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 Units 
No. of Hours for Theory 

and Practical 
  

Max. Marks 

Part A Employability Skills   

 Unit 1:  Communication Skills – III 13 

10 

 Unit 2:  Self-management Skills – III 09 

 Unit 3: Basic ICT Skills- III 
06 

 Unit 4: Entrepreneurial Skills – III 16 

 Unit 5: Green Skills -  III 06 

 Total 50 10 
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Unit 1 Communication Skills –III 

Learning Outcome 
  

Theory 
 Periods 

Practical 
Periods 

Total 
Duration 
Periods 

1. Demonstrate knowledge of 
various methods of 
communication  
 

1. Methods of 
Communication 

 Verbal 
 Non-verbal 
 Visual 

1. Writing pros and cons of 
written, verbal and non-
verbal communication. 

2. Listing do’s and don’ts 
from language mistake 

 
3 

2. Identify specific 
Communication styles  
 

1. Communication 
styles- assertive, 
aggressive, passive- 
aggressive, 
submissive, etc. 

1. Observing and sharing 
communication styles of 
friends, teachers and 
family members and 
adapting the best 
Practices 

2. Role plays on 
Communication styles. 

4 

3. Demonstrate basic writing 
skills  
 

1. Writing skills to the 
following: 

 Sentence 

 Phrase 

 Kinds of 
Sentences 

 Parts of Sentence 

 Parts of Speech 

 Articles 

 Construction of a 

 Paragraph 

1. Demonstration and 
practice of writing 
sentences and 
paragraphs on topics 
related to the subject 

6 

Total 13 
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Unit 2 Self-management Skills –III  

Learning Outcome 
Theory 

( Periods) 
Practical 
( Periods) 

Total 
Duration 

( 09 
Periods) 

1. Demonstrate impressive 
appearance and grooming 

1. Describe the 
importance of 
dressing 
appropriately, looking 
decent and positive 
body language 

2. Describe the term 
Grooming 

3. Prepare a personal 
grooming checklist 

4. Describe the 
techniques of self-
Exploration 

1. Demonstration of 
impressive appearance 
and groomed 
personality 

2. Demonstration of the 
ability to self- explore 

 3 

1. Demonstrate team work 
skills 

1. Describe the 
important factors that 
influence in team 
building 

2. Describe factors 
influencing team work 

1. Group discussion on 
qualities of a good 
team  

2. Group discussion on 
strategies that are 
adopted for team 
building and team 
work 

 3 

1. Apply time management 
strategies and techniques 

1. Meaning and 
importance of time 
management – 
setting and 
prioritizing goals, 
creating a schedule, 
making lists of tasks, 
balancing work and 
leisure, using 
different optimization 
tools to break large 
tasks into Smaller 
tasks. 

1. Game on time 
management   

2. Checklist preparation 
3. To-do-list preparation 

 3 

Total 9    
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Unit 3: Information & Communication Technology – III 

Learning Outcome 
Theory 

(      Periods) 

Practical 

(    Periods) 

Total 

Duration 

(07 Periods) 

1. Create a document on word 
processor 

1. Introduction to word 
Processing. 

2. Software packages 
for word processing. 

3. Opening and exiting 
the word processor. 

4. Creating a 
document 

1. Demonstration and 
practice of the following: 

 Listing the features of 
word processing 

 Listing the software 
packages for word 
processing 

 Opening and exit the 
word processor 

 Creating a document 

 3 

2. Edit, save and print a 
document in word 
processor 

1. Editing Text 
2. Wrapping and 

aligning the text 
3. Font size, type and 

Face 
4. Header and Footer 
5. Auto correct 
6. Numbering and 

bullet 
7. Creating table 
8. Find and replace 
9. Page numbering. 
10. Printing document 
11. Saving a document 

in various formats. 

1. Demonstration and 
practicing the following: 

A. Editing the text 
B. Word wrapping and 

alignment 
C. Changing font type, 

size and face 
D. Inserting header and 

Footer 
E. Removing header 

and Footer 
2. Using autocorrect 

option 
3. Insert page number 

and Bullet 
4. Save and print a 

Document 

 3 

Total 6  
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Unit 4: Entrepreneurial Skills – III 

Learning Outcome 
Theory 

  Periods 

Practical 

 Periods 

Total 

Duration 

 Periods 

1. Describe the significance 
of entrepreneurial 

1. Values in general and 
entrepreneurial values 

2. Entrepreneurial value 
orientation with 
respect to 
innovativeness, 
independence, 
Outstanding 
performance and 
respect for work 

1. Listing of 
entrepreneurial 
values by the 
students. 

2. Group work on 
identification of 
entrepreneurial 
values and their roles 
after listing or reading 
2-3 stories of 
successful 
entrepreneur  

3. Exhibiting values in 
Ice breaking, rapport 
building, group work 
and home 
assignments 
 

 

8  

2. Demonstrate the 
knowledge of attitudinal 
changes required to 
become an entrepreneur 

1. Attitudes in general 
and entrepreneurial 
Attitudes 

2. Using imagination/ 
3. Intuition Tendency to 

take moderate risk 
4. Enjoying freedom of 

expression and action 
5. Looking for economic 

Opportunities 
6. Believing that we can 

change the 
Environment 

7. Analyzing situation 
and planning action 

8. Involving in activity 
 

1. Preparing a list of 
factors that influence 
attitude in general and 
entrepreneurial 
attitude 

2. Demonstrating and 
identifying own 
entrepreneurial 
attitudes during the 
following micro lab 
activities like thematic 
appreciation Test 

3. Preparing a short 
write-up on “who am I” 

4. Take up a product and 
suggest how its 
features can be 
improved 

5. Group activity for 
suggesting brand 
names of enterprises, 

8  

Total 16  
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Unit 5: Green Skills – III 

Learning Outcome 
Theory 

(    Periods) 

Practical 

(    Periods) 

Total 

Duration 

( 06 Periods) 

1. Describe importance of 
main sector of green 
economy 

1. Main sectors of green 
economy- E waste 
management, green 
transportation, renewal 
energy, green 
construction, water 
Management 

2. Policy initiatives for 
greening economy in 
India 

1. Preparing a poster 
on any one of the 
sectors of green 
economy. 

2. Writing a two-page 
essay on important 
initiatives taken in 
India for promoting 
green economy 

3  

2. Describe the major green 
Sectors/Areas and the role 
of various stakeholder in 
green economy 

1. Stakeholders in green 
Economy 

2. Role of government and 
private agencies in 
greening cities, 
buildings, tourism, 
industry, transport, 
renewable energy, 
waste management, 
agriculture, water, 
forests and fisheries 

1. Preparing posters 
on green 
Sectors/Areas: 
cities, buildings, 
tourism, industry, 
transport, 
renewable energy, 
Waste, 
management, 
agriculture, water, 
forests and 
fisheries 

 3 

Total 6  
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1 Communication skills – XI 

 

   

What is communication? 

Communication is the act of conveying messages/ information from one entity or group to another through the use of 

mutually understood signs, symbols, and semiotic rules.                            

    *The following figure represents types of communication 

                                      (Fig 1) 

         Learning objectives of Effective communication 

1. Development of Interpersonal Skills 

2. To express effectively with maximum efficiency 

Verbal communication is the use of language to transfer/share information through speaking or sign language. It is 

one of the most common types, often used during presentations, video conferences, phone calls, meetings and one-

on-one conversations. Verbal communication is important because it is efficient. It can be helpful to support verbal 

communication with both non - verbal and written communication. 

 Non - verbal -Non - verbal communication is the use of body language, gestures and facial expressions to convey 

information to others. It can be both intentional  or unintentional. 

Non - verbal communication is helpful when trying to understand others’ thoughts and feelings. 

Visual communication is the act of using photographs, videos, art, drawings, sketches, charts and graphs to convey 

information. Visuals are often used as an aid during presentations to provide helpful context alongside written and/or 

verbal communication.  Sincepeople have different learning styles, visual communication might be more helpful for some 

to consume ideas and information..  

Written communication is the act of writing, typing or printing symbols like letters and numbers to convey information. It 

is helpful because it provides a record of information for reference. Writing is commonly used to share information 

through books, pamphlets, blogs, letters, memos, e - mail, SMS and more. Emails and chats are a common form of written 

communication in the workplace. 

The major advantages of written communication are listed below: 

     1. Permanent Record: 

A written communication helps to maintain a permanent record of the information exchanged or shared. 

     2.Meticulous Presentation: 
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As written document is a permanent record, people are very cautious to fulfil all the writing requisites to make the 

writing perceivable at the other end. Thus, every document curated covers all major information pointers necessary 

to be communicated. 

    3. Easy Circulation: 

. A written document can easily be circulated in an organisation, unlike the oral communication medium. Thus, this 

attribute of written communication comes handy in equipping the masses with the necessary information. 

4. . Suitable for Statistical Data: 

  Statistical charts and figures are difficult to be interpreted verbally, thus, circulating a document allow people to 

examine such intrinsic detail with ease. 

5..Promotes Goodwill:  

When conducting business, a well-crafted written document speaks volumes about the competence of a particular 

organisation. Therefore, written communication helps to promote goodwill, if performed wisely. 

Disadvantages of Written Communication: 

The main disadvantages encountered are: 

1.Time consuming: 

In order to craft an impeccable piece of document, one has to invest an ample amount of time which is indeed 

difficult in constrained timelines. 

 2.Non-flexible: 

A written document cannot be altered once circulated. This makes written communication non-flexible as every written 

word is concrete and final. 

 3.No Scope for clarification: 

If the document is not curated keeping the less informed person’s mindset in check, the details cannot be perceived by 

such people via the formulated written document. 

     4.Demands criting proficiency: 

In order to deliver the message adequately across the other end, one should have competencies in the writing sector. 

5.Probability of wrong Interpretation: 

If there are complex words or difficult sentences included  in the written  document, one may interpret a wrong/no 

meaning out of it. Thus, in order to use written communication, one should make use ofeasy language.. 

Advantages of Verbal Communication Skill: 

1.It saves time: 

. The verbal form of communication gives you this facility to quickly send intended message thus saving time.  

2.It saves you money, as no printing or arranging of material is involved.  

3.Feedback quickness: 

The distinct advantage of verbal communication is  the fact that the receiver can ask and clarify his doubts on the spot 

without any delay. The sender can get quick feedback as to whether his intended message is received in its intended form 

or not and can clarify the receiver, in  case of any doubt. 4.Ease of preparation: 

Oral communication is the easiest way of communication as it does not require preparation of any material.  

5. Most convenient method: 

Verbal communication is the most widely adopted means of communication globally. People prefer more of verbal 

communication due to the convenience factor. While communicating verbally, you are more likely to convey matter 

simply, in plain understandable language which is widely preferred. 
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Disadvantages of Verbal Communication: 

1.Chances of distortion in meaning: 

Due to the presence of various barriers in effective communication, it happens that the intended meaning of the message 

changes for the intended person which causes a lot of problems in the future. 

2.Not convenient for long messages: 

It is not at all convenient to convey long messages orally as it may happen that by the time message is completed, the 

receiver may forget the previously spoken important points leading to a chance of ineffective communication. As a result, 

the written format can be used. 

3.Irrelevant information: 

While having an important discussion, a lot of irrelevant information can creep in during a conversation leading to a waste 

of time and gap in the relevant information. This leads to unnecessary  waste of time and sometimes omitting or forgetting 

to converse on what is really important. Therefore, it is always necessary to keep your communication process clear of any 

unwanted discussion that may lead to wastage of your precious time and energy.4. Misunderstanding: 

Usually, when two individuals are having deep conversations, they can have some misunderstandings during the time. 

Sometimes subtle hints given or some words spoken with some intention get misinterpreted and a whole new different 

meaning comes out of it. Thus, it becomes crucial to know that what you have spoken or written has a crystal - clear 

meaning with no indirect hints that could make a conversation difficult. 

  Advantages of non-verbal communication: 

1.Complementary: Non-verbal cues complement a verbal message by adding to its meaning.  

2.Easy presentation: Information can be easily presented in non-verbal communication through using visual, audio-visual 

and silent means of non-verbal communication. 

3.Substituting: Non-verbal messages may substitute for the verbal message especially if it is blocked by noise, interruption, 

long-distance, language barrier etc. For example; gestures-finger to lips to indicate need for quiet, facial expressions- a nod 

instead of a yes. 

4.Reducing wastage of time: The message of non-verbal communication reaches the receiver very fast. Non-verbal cues of 

communication like sign and symbol can also communicate some messages very quickly than written or oral messages. 

Disadvantages or limitations of non-verbal communication: 

Despite of advantages of non-verbal communication, it is not free from its limitations or disadvantages which are: 

   1.Vague and imprecise: Non-verbal communication is quite vague and imprecise. Since in this communication, there is no 

use of words or language which expresses clear meaning to the receiver, no dictionary can accurately classify them. Their 

meaning varies not only by culture and context but by the degree of intention also. 

2.Continuous: It is possible to stop talking in verbal communication, but it is generally not possible to stop non -verbal 

cues. Also, spoken language has a structure that makes it easier to tell when a subject has changed, for instance, or to 

analyze its grammar. Non - verbal communication does not lend itself to this kind of analysis. 

3. While watching someone’s eyes, you may miss something significant in a hand gesture. Everything is happening at once 

and therefore it may be confusing to keep up with everything. 

4.Culture-bound: Non-verbal communication is learned in childhood, passed on to you by your parents and others with 

whom you associate. A few other gestures seem to be universal. Evidence suggests that humans of all cultures smile when 

happy and frown when unhappy. However, most non - verbal symbols seem to be even further disconnected from any 

“essential meaning” than verbal symbols.  

5.Long conversations are not possible: In non-verbal communication, long conversation and necessary explanations are 

not possible.  

             D0’s and Don’ts of Languageusage 
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                     DO’S                     DON’TS 

Use formal language Do not use slang, jargon, colloquialisms 

Use the full verb form instead, e.g. they are, is not, cannot Do not use shortened verb forms (contractions), such as they're, 
isn't, can't. 

Make more formal vocabulary choices, e.g. have found, a 
great deal, attractive/ advantageous,  the other, behind 
issue/problem/notion/idea/topic etc.. 

Do not use common vocabulary, such as have got, a lot, nice, the 
other thing, at the back of. 

Leave out conversational phrases. Use appropriate 
connectors and introductory phrases. 

Do not use conversational opening phrases, such as Well, you 
see, Yes…, Let's move on. 

Be non-personal, e.g. It should be possible for everyone to 
compete. 
 
 

Do not use personal pronouns e.g. I, you, we (unless specifically 
required), i.e. do not write We think that you should be able to 
compete. 

Use complete sentences and link these into logical 
paragraphs. 

Do not use bullet points or lists, unless it is in a report. 

Be objective. Avoid making assumptions or giving your opinion (unless 
specifically asked). 

Be clear and concise. Avoid waffling or repeating yourself. 

Convert questions into statements, for example, The 
possibility of carbon emissions being reduced is 
questionable. 

Do not pose (direct) questions in the running text, that is, do not 
write, for instance: Can carbon emissions be reduced? 

Check spelling, grammar and punctuation etc.  
Proofread and use a dictionary. 
Ask somebody to proofread your text.. 

Do not take for granted that the spell check on your computer is 
accurate or will spot all spelling mistakes. for example: your spell 
check will not pick up on whether vs weather.  
Also, spell check on US or British English shall be different. 

Use words(number names)for numbers nine and below 
and numbers(digits) for 10 and above. 

Do not mix words and numbers unsystematically. 

             

 

            Worksheets 
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Can you find and correct the common mistakes  speakers make? 

1. Spanish people is very friendly. 

2. I will ask to my mother tonight. 

3. I knew Paul at a party last year. 

4. All the days I go to the office. 

5. At the end, I was able to finish my homework. 

6. My friend who works for Sony he is an engineer. 

7. I’m lawyer, but I also teach English sometimes. 

8. We are twelve in my English class. 

9. It was a good party, no? 

10. Do you know Africa? 

11. I haven’t money since I lost my job. 

12. I’ve been learning English since two years. 

13. I’m boring when I have nothing to do. 

14. I lived in Japan during three years. 

15. I’m agree with you. 

16. I’m going to the shops for to buy some food. 

17. He said me that he was tired. 

18. I don’t used to go to the gym any more. 

19. I was in New York the last week. 

20. The French food is delicious. 

21. My birthday is on January. 

22. He likes read books and play the guitar. 

23. I have two brothers, Maria and Juan. 

24. Can you borrow me a book please? 

25. He won two millions of Euros in the lottery. 

26. She drinks much coffee every day. 

27. I practice football every Saturday. 

28. He doesn’t have nothing to do. 

29. I like dancing a lot of on the weekend. 

30. Last year I went on a travel with my friends. 

31. I born in Buenos Aires twenty years ago. 

32. Yes, I like very much. 

33. More persons came than we expected. 

34. Susan works very hardly. She is a workaholic. 

35. He is in Canada since April. 

36. I’m sorry.  In this moment I am very busy. 

37. She must to do it now. 

38. In my opinion, depends of the person. 

39. They want that I go there. 

40. I like reading too much.  It’s my favourite hobby. 

41. Toledo is near of Madrid. 

42. Can you explain me this? 

43. My teacher puts us lots of grammar exercises. 

44. He asked me where is the bank. 

45. Is important to do this exercise. 
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                Communication styles 

 

Every person has a unique communication style, a way in which they interact and exchange information with others. 

 There are four basic communication styles: passive, aggressive,    passive-aggressive and assertive. 

It’s important to understand each communication style, and why individuals use them. For example, the assertive 

communication style has been found to be most effective, because it incorporates the best aspects of all the other styles. 

  PASSIVE 

Individuals who use the passive communication style often act indifferently, yielding to others. Passive communicators 

usually fail to express their feelings or needs, allowing others to express themselves. 

Passive communicators often display a lack of eye contact, poor body posture. 

 

 Examples of phrases commonly used by passive communicators:  “It really doesn’t matter that much.” 

 “I just want to keep the peace” 

 Aggressive 

The aggressive communication style is emphasized by speaking in a loud and demanding voice, maintaining intense eye 

contact and dominating or controlling others by blaming, intimidating, criticizing, threatening or attacking , among other 

traits.  

Aggressive communicators often issue commands, ask questions rudely, do not give chance for others to speak and fail to 

listen to others. 

Examples of phrases that an aggressive communicator would use include: 

 “I’m right and you’re wrong.” 

 “I’ll get my way no matter what.” 

 “It’s all your fault.” 

 “Just listen to me” 

Passive-Aggressive 
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Passive-aggressive communication style users appear passive on the surface, but within he or she may feel powerless or 

stuck, building up a resentment that leads to seething or acting out in subtle, indirect or secret ways. 

Most passive-aggressive communicators will mutter to themselves rather than confront a person or issue. Passive-

aggressive communicators are most likely to communicate with body language. .Ultimately, passive-aggressive 

communicators are aware of their needs, but at times struggle to voice them. 

Examples of phrases that a passive-aggressive communicator would use include: 

 “That’s fine with me, but don’t be surprised if someone else gets mad.” 

 “Sure, we can do things your way” (then mutters to self that “your way” is stupid). 

 Assertive 

Assertive communicators can express their own needs, desires, ideas and feelings, while also considering the needs of 

others. Assertive communicators aim for both sides to win in a situation, balancing one’s rights with the rights of others. 

Examples of phrases an assertive communicator would use include: 

 “We are equally entitled to express ourselves respectfully to one another.” 

 “I realize I have choices in my life, and I consider my options.” 

 “I respect the rights of others.” 

  Role play on different communication styles( ACTVITY) 

OBJECTIVE:  Have fun reflecting on our own communication styles, and consider which can be most effective in bringing 

our issues forward. 

HOW: 

• Role Play ( 3 min) 

 Select a neighbourhood problem the group can relate to (Ex.  Garbage clean up) and practice a short role-play (2 – 3 

min) to demonstrate three communication styles.  The players might be: two facilitators and a participant. The 

aggressive and passive people play the role to an extreme, so that it is so obvious that it is funny.  Their behaviour 

starts to change when the proactive person demonstrates a more constructive approach. 

AGGRESSIVE: (wears a very large yellow star) Walks into the scene very confident of his/her ideas, imposing them on 

everyone else. 

PASSIVE: (wears a very small yellow star) When expressing his/her ideas can hardly be heard, and allows the 

aggressive player to dominate. 

PROACTIVE(type of assertive): (wears a large yellow star) Steps into the scene after  other two have already demonstrated 

their styles.  He/She listens to  others, clarifies what they are saying, takes a few moments to consider what she/he is 

hearing and suggests some positive action for them to consider.  

• Large group reflection (8 min) 

Ask:  “What happened?  What were the different ways of addressing the situation?” 

Note:  Keep the conversation focused on the communication style, not the issue.  

 Worksheet 

WHAT IS YOUR COMMUNICATION STYLE?  

Directions: Select the answer that describes how do you communicate most often. P = Passive, AG = Aggressive, P/A = 

Passive Aggressive, and AS = Assertive. Put a tick on one/two of the choices that suit you most. 

1. My friends would call me 

  P : shy _________ 

  AG: loud__________ 
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P/A: sarcastic_______ 

AS: confident _______ 

2. I usually: 

 P: don’t share my opinions even though I have them._______ 

AG: share my opinions in a demanding way._______ 

P/A: have opinions but don’t share them and then become angry towards everyone involved.________ 

AS: have opinions and share them with others while being open and respectful to the opinions of others. 

3. I feel: 

P: that the opinions of others matter more than my own.____________ 

AG: that my opinions matter more than the opinions of others.___________ 

P/A: that I will follow the opinions and ideas of others but talk badly about them behind their backs._____________ 

AS: that my needs are important and so are the needs of others._______________ 

4. When walking into a crowded room: 

P: I want to hide my face._______ 

AG: I don’t mind pushing my way through the crowd.__________ 

P/A: I may push someone out of my way and then blame it on someone else._________ 

AS: I smile and say “hi” to others and respect other people’s space.___________ 

5. I often: 

P: ignore problems.__________ 

AG: cause problems___________ 

P/A: hide problems._____________ 

AS: solve problems.____________ 

Many people mistakenly confuse aggressiveness with assertiveness, which is not true. Aggressiveness is behaving in a 

hostile way. Assertiveness is standing up for your right to be treated fairly and/or advocating for yourself in a clear, direct, 

and honest way that is positive and proactive. It is expressing your opinions, needsand feelings, without ignoring or hurting 

the opinions, needsand feelings of others. Assertiveness is actually one of the most positive skill sets you can use and 

develop for lifelong success. 

Select the Assertive Communication method from the choices and see if you can identify the other methods of 

communication as you read through the choices. 

 In class: 

A. I’m too afraid to raise my hand even though I know the answer._________ 

B. I shout the answer because I always know them and no one else ever does. 

C. I know the answer but never participate and then get angry at other people who do. 

D. I raise my hand when I know the answer and give others the opportunity to do the same. 

2. You got a bad grade on a test and you’re not sure why. What do you do? 

A. You ask the teacher to talk after class. You respectfully explain your confusion about your grade and ask what you can do 

differently next time. 

B You don’t say anything but you talk badly about the teacher behind his/her back. 



11 Communication skills – XI 

 

C. You don’t say anything. It’s not a big deal. 

 3. Someone cuts(barges) in front of you in line… 

A. Say nothing, but glare at them and "accidentally" push them a little. 

B. Say nothing and do nothing. 

C. Assume they didn't know you were in line; gently explain that you were waiting before them.  

D. Yell at them and shout for them to return to their place. 

 

Continue using the Assertive Communication method, answer these next set of questions. Write in your actual response 

to the situation in the space provided: 

a) There was a test in one of your classes on a day that you were absent. You were legitimately sick, but don’t have a 

doctor’s note. 

The teacher tells you that since you don’t have a note, you are not allowed to write the test which jeopardizes your entire 

credit. 

____________________________________________________________________________________________________

____________________________________________________________________________________________________

________________________________________________________ 

b) A friend wants to go for a movie, however you want to go and see something different. 

____________________________________________________________________________________________________

____________________________________________________________________________________________________

______________________________________________________ 

 What is Writing? 

Writing is a form of communication that allows students to put their feelings and ideas on paper, to organize their 

knowledge and beliefs into convincing arguments, and to convey meaning through well-constructed text. In its most 

advanced form, written expression can be as vivid as a work of art.                                   

1. Sentences. 

The main focus here is to improve basic sentence composition skills. One can review the types of sentences and the 

functions of their component parts listed below. 

Simple, compound, and complex sentences 

a)  Simple sentence- 

 A simple sentence is one independent clause that has a subject and a verb and expresses a complete thought. Notice 

that there are some important requirements for a simple sentence: 

 Must have a subject and a verb. 

 Must express a complete thought. 

 Must only have one clause. 

Examples 

 I am out of paper for the printer. 

 Will you help me with the math homework? 

b) Compound Sentence 

A compound sentence allows us to share a lot of information by combining two or more related thoughts into one 

sentence. It combines two independent clauses by using a conjunction like “and.” This creates sentences that are 

more useful than writing many sentences with separate thoughts. 

      Example of Compound Sentences 
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 We use compound sentences quite often. . Here are some examples, the  independent clause is green, the second is 

purple, and the conjunctions are    orange: 

1.I drove to the office, and then I walked to the cabin.  

c) Complex sentence  

A complex sentence is a sentence that combines one independent clause with at least one dependent clause. 

 Example 

  Although Rohan had some doubts, he found the courses very useful. 

The above example is a complex sentence: it has a dependent clause (a subject ' Rohan' and a verb 'had'), followed by an 

independent clause (subject 'he' and a verb 'found') and forms a complete thought. 

 Computers have come a long way since they first came in  the market. 

This example begins with an independent clause (subject 'computers' and verb 'have come') that forms a 

complete thought, followed by a dependent clause (subject 'they' and a verb 'came'). 

 https://study.com/academy/lesson/types-of-sentences-simple-compound-complex.html#lesson  

The link mentioned above will further help the students to strengthen their concept on the above-mentioned topics. 

 

     Writing skills 

 This activity simulates ‘chatting’ – a popular (online) communication  can be used in the language-learning classroom for 

students who still find it too difficult to write without first having a little ‘thinking’ time, and also as a means of moving 

students away from being overly concerned with accuracy, and focussing more on successful communication. The students 

really enjoy this activity, especially the fact of being ‘allowed’ to write notes in the class. 

The students will need one piece of paper for writing  simple sentences. To encourage students to write brief messages 

each time, this could be in the form of a ‘chatting page. ( The activity will be done in pairs) 

                                            Chat sheet 

Student A     

Student B  

Student A  

Student B  

  

  

 

https://study.com/academy/lesson/types-of-sentences-simple-compound-complex.html#lesson
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A suitable subject for the students to ‘chat’ about is chosen such as: ‘Discuss your favourite sports’. Subjects requiring 

students to reach a solution are particularly effective, for example: ‘Arrange to meet up a client at the weekend and decide 

what you are going to build up business. 

 It will be explained to students that in order to communicate, they write a message on the first line of their 

paper, say ‘Hi, how are you?’, and ‘send’ it over their shoulder to their partner, who will respond and pass the 

paper back as quickly as possible. 

This activity will help them to engage themselves in conversations and communicate better. 

      A worksheet can be taken up in the class to test the concept clarity.                     

 
                                              Worksheet 
Choose your answers to the questionsbelow. . 
   Do as directed 

a) How many clauses appear in the sentence below? 
     When he woke up that morning, Joseph wondered about his chances at getting the job, but he shrugged off any doubts. 
       i)Two 
       ii)Three 
       iii)One 
      iv)Five 
       v)Four 

b) Which of the following sentences has an INCORRECT subject-verb agreement? 
i)Subject-verb agreement usually gets trickier as sentences expand into more complex structures. 
ii)It's amazing that there are never any leftovers in my house after the Super Bowl game. 
iii)The thought of all the home repairs we need after the bathrooms flooded are daunting. 
iv)Any book about space visits from vampire Martian aliens is my idea of a good weekend read. 

c) Which of the following pronouns must ALWAYS be paired with a plural verb? 
 

i)Few, many, both, others, and several. 
ii) Most, any, none, some, and all. 
iii) Politics, gymnastics, mathematics, and news. 
iv) Whomever, whichever, they, and themselves. 
 
(d) Silence is golden when you can't think of a good answer.' - Muhammad Ali 

In this famous quote, which choice best describes the second part of the sentence 'when you can't think of a good answer?' 
i)Compound sentence 
ii) Simple sentence 
 iii)Dependent clause 
iv)Complex sentence 
 v) Independent clause 

       e) What is wrong with the following sentence? 
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        Clint didn't talk much he just stared you down with cold, dead eyes. 
        i) It has a comma splice. 
 
      ii)It is a sentence fragment. 
      iii) It is a regular run-on sentence. 
     iv) He' should be capitalized. 
 
 
     

 

 

 2.Phrases - Phrases are a group of words that work together to communicate an element of speech. 

                                                

 

 Types of phrases   

1.Noun Phrase 

A noun phrase is any noun or pronoun along with its modifiers.Example –  

 The school children 

 Yesterday’s newspaper 

2. Verb Phrase 

A verb phrase is any number of verbs working together. 

              Example 

 Had been sleeping 

 Will contact 

 May have written 

3. Prepositional Phrase 

A prepositional phrase always starts with a preposition and ends with a noun or pronoun (and its modifiers) that is called 

the object of the preposition. 

        Example 

 Through the wheat field 

Here, the preposition: through 

Object of the preposition: the wheat field 

   Some more examples of prepositional phrases: 

 During the year 

 Despite complaints 

4. Verbal Phrases 

There are three types of verbal phrases: participial phrases, gerund phrases, and infinitive phrases. Each is explained 

below. 

a) Participial Phrase 
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Participial phrases start with either a present or past participle. Here are some examples of each. 

Phrase with present participles: 

 Watching silently 

Phrases with past participles: 

 Driven to succeed 

b) Gerund Phrase 

A gerund phrase is a present participle (and its modifiers) that acts like a noun. It can take on a variety of jobs in 

the sentence. Here are a couple of examples: 

 Practicing helped a lot. (subject) 

 I love reading. (direct object) 

c) Infinitive Phrase 

An infinitive phrase is a group of words that uses infinitive and its modifiers. 

Example 

 To sing 

 To walk all that way 

5. Appositive Phrase 

An appositive phrase is a phrase that renames an earlier noun or pronoun 

My best friend, Nick Palacio, loves scuba diving. 

We watched Sirius, the brightest star in the sky 

d) 6.Absolute Phrase 

Absolute phrases are the trickiest to identify. These phrases are not closely connected to rest of the sentence; they 

don’t describe a specific word, but modify the whole sentence. They add extra information and are usually separated 

by commas (or dashes). Example 

The semester finished, Karen sold all her textbooks. 

           Absolute phrase: The semester finished 

A worksheet can be taken up in the class to further build the  concept. 

 
 
             For each sentence, Identify the phrase in bold font. 
  
 
1.I wish the university that I attend would have an annual kite flying festival in spring time. 
 
2. I am pretty sure I have been told that I'm a good listener. 
 
3.My hero, the man in the moon, has not yet delivered a TED talk. 
    
 4.She sang a traditional song called "Over the Hills and Far Away." 
    
 5.It’s all spread by word of mouth. 
   
6. The Bill Gates Foundation does much charitable work. 
 
7.Bungee jumping is not a sport that I would try, since it does not seem entirely safe to me. 
 
8. Our lawyer, William Weary, takes care of all of our speeding tickets, but his bills end up costing just as much. 
  
9.To marry him was out of the question. 
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10.Dreaming away, Tristan did not notice that the lights had changed. 
 
 

 

       Writing Skills  (Consumer power) 

  We are all to some extent consumers, so this is a subject that students of all nationalities and ages should be able to 

identify with. 

  

 

 

Activity - Consumer quandary cards 
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 A hypothetical situation will be given to students related to present day scenario and they will be asked to present/write 

their views on the same. The following activity will help them to identify and find a solution  to present day consumerism 

related issues . 

( Example) 

You have a favourite brand of trainers that you love. You have asked your parents for a pair of these trainers as your 

birthday present. Last night you saw a documentary on the TV that showed where this brand of trainers is made and you 

saw that they are made in huge factories by children who have to work 14 hours per day and are treated badly. What do 

you do? Do you still want a pair of these trainers for your birthday? 

Kinds of sentences 

                            

 

In writing and speaking, there are four basic kinds of sentences: 

 Declarative sentences 

 Interrogative sentences 

 Imperative sentences 

 Exclamatory sentences 

a) A declarative sentence is the most basic type of sentence. Its purpose is to relay information, and it is 

punctuated with a period. For example:I walked home. 

b) Interrogative sentences interrogate, or ask questions. These are direct questions, and they are punctuated with 

a question mark. For example: 

 Why haven’t you completed your work? 

c) Exclamatory sentences are like declarative sentences in that they make a statement instead of asking a question, 

but their main purpose is to express strong emotion. They are easily recognized because they end in an 

exclamation point instead of a period: For example 

 Wow, he just got an appraisal! 

d) Imperative sentences do not simply state a fact but rather tell someone to do something. These can be in the 

form of friendly advice, basic instructions or more forceful commands. For example: 

 

 Turn left at the bridge. 

 

Using Different Sentence types to add variety to Writing 

Writing skill- News report 

Students are guided through the processes of collecting information and deciding how they will structure it within the text 

before they begin to write. Students are guided through the process of drafting, editing and redrafting the text to produce 

a final copy. 

1. Write up a headline  

For eg –   A report about an event ( for eg.-  Independence day celeberations) 

2. The students in groups will discuss the content of write up. 

3. A pile of about 10 or 15 slips of paper will be provided to the students.  
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4.  The students will write a question about the content on each slip of   paper.  

The following Editors checklist will help them to organise their thoughts in a more constructive way 

    Editor's checklist: 

• Is the information grouped into logical paragraphs? 

• Are the paragraphs in a logical order? 

• Is there any unnecessary information? 

• Is any necessary information missing? 

• Are there any parts that you can't understand? 

• Is there repetition of words?• Can more precise words be used? 

 • Is the punctuation correct? 

• Have all the words been spelt correctly? 

 This will develop students’ abilities to organise information and construct it into a text. 

          Parts of a sentence-  

             Every sentence can be broken into two parts:  

a) Complete Subject 

b) Complete Predicate 

 The complete subject consists of simple subject  and its modifiers 

 The complete predicate is made up of verb and its modifiers. 

                                 (Fig 4) 

 

The subject of a complete sentence is who or what the sentence is about, and the predicate tells about that subject. 

Yesterday, after lunch the students were complaining about the short recess.  

The students” is  the subject (red) of the sentence. The predicate always includes verb, and tells something about the 

subject; in this example, the students ( purple)“were complaining about the short recess.” 

    Writing skills - Here we will explore the theme of social media. Students will create an imaginary online 'wall' where they 

can interact with each other. 

                                Creating social networking profile 

                                             (Basic information) 

Name  
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Age  

Gender  

Location  

Hometown  

Interested in( Hobbies)  

 Strengths  

Why I am here 
( few lines) 

 

Personality( Introvert/ 
Extrovert) 

 

 Self-Introduction  

 

   This activity will help the students to make contacts, communicate and       express themselves better. 

 Parts of speech-  A category to which a word is assigned in accordance with its syntactic functions. In English the main 

parts of speech are noun, pronoun, adjective, verb, adverb, preposition, conjunction, and interjection. 

The following figure represents eight parts of speech 

                                           

1.  NOUN- A noun is the name of a person, place, thing, or idea. Eg. 

      London,Flower,Happiness 

2. PRONOUN-  A pronoun is a word used in place of a noun.eg. 

       She, we,they, it 

 3. VERB- A verb expresses action or being.eg.  

       Jump ,is,become 
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4. ADJECTIVE -An adjective modifies or describes a noun or pronoun.eg. 

      Pretty,old 

 5. ADVERB -An adverb modifies or describes a verb, an adjective, or another adverb. Eg.  

   Gently, extremely 

6. PREPOSITION -a preposition is a word placed before a noun or pronoun to form a phrase modifying another word in the 

sentence.eg. 

By,with, 

7.  CONJUNCTION -A conjunction joins words, phrases, or clauses. Eg. 

The young girl brought me a very long letter from the teacher and then she quickly disappeared. 

8. INTERJECTION - An interjection is a word used to express emotion.eg. 

Oh! Wow! 

The following link will help to reinforce the concept 

(https://www.youtube.com/watch?v=v9fCKTwytJA) 

 (Writing skill) 

Activity  

Adopt a word 

Students will be given templates with a heading 

Word Meaning Part of speech Example of usage 

    

 The students choose a word that they would like to adopt and do some research on it using the template as 

above. 

 Each student then gives a short presentation on his or her adopted word until all the students get a chance.. 

 The words are then stuck to a large paper chart on the wall. 

In between, quizzes can be organised about the new words. The students greatly enjoy contributing words, researching 

and presenting.  

 This activity will help the students to streamline their thoughts and build up their vocabulary. 

 Article writing 

Article writing is the process of creating a non-fiction text about current or recent news, items of general interest or 

specific topics. 

The following figure represents the format of Article writing 

                                              * Figure 5 

https://www.youtube.com/watch?v=v9fCKTwytJA
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 The following link will help to build up the concept 

https://youtu.be/q2197KT1iNE?list=RDQMaJwsUDCsYv4 

Example 

 You are Renu/Ronit. Write an article in 1OO-120 words for your school magazine on journalism as a career. 

• Hints – Journalism suitable for those who are good at language’ 

•  Ones who desire to present truth to the public 

Activity  

 Media diary 

Students write about the different ‘media’ that they have been watching or reading. This could include TV programmes, 

films at the cinema or on DVD, websites that they have been looking at, magazines, books, etc. This will help the students 

to have clarity about present day situations and organise their thoughts in a more constructive way.  

   Construction of the Paragraph 

     What is a paragraph? 

    A paragraph is a series of sentences that are organized and coherent, and are all related to a single topic. 

 

 

 

Activity –  Writing a class Journal 

 Introduction 

https://youtu.be/q2197KT1iNE?list=RDQMaJwsUDCsYv4
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Class journal described here is designed to get the students writing freely in a range of different ways.  The emphasis is on 

fluency, as opposed to any kind of genre writing, and could be compared to the kind of oral fluency activities done with 

students.  Rather than focusing on accuracy, or a particular style,  students can use their language resource to express their 

ideas in any way that seems best to them; in this way, we will help them to build a writing habit, and to write more 

confidently.  

    The journal can be divided into following 

1. Creating a front cover 

2. First page-  Personalised writing by the students 

For example 

 3 things that you enjoy doing 

 3 people that are important to you 

 3 things that you enjoy doing 

3. 3 films / books / TV programmes that you like, and why you like Second page- Learning questionnaire 

 Dictate the following sentences 

 to students. Students will write the sentences and complete 

them, so that they are true for themselves 

                     For example : 

 I think that learning English is… 

 The most difficult to me about English is… 

 The easiest thing is... 

 The best way to remember vocabulary is... 

4. Third Page - Character writing 

The students will be shown following YouTube clip. Students watch the clip and discuss the following: What is being 

advertised? Is it being done effectively? 

The Power of Words: 

http://www.youtube.com/watch?v=Hzgzim5m7oU&f 

  Same way we can add different pages to hone and improve writing skills of students. Working as a team will help to know 

each other better. 

Persuasion skills 

Activity-  

Purpose 

In this team building exercise,  students work together to complete a task. It requires concentration, planning and fast 

execution. Here, the decisions made by one team can affect the performance of another so planning has to be dynamic as 

the changing environment. This exercise is ideal to train people on quick decision making, leadership, persuasion skills and 

team work. 

 

http://www.youtube.com/watch?v=Hzgzim5m7oU&f
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This exercise helps students to brainstorm how to cross sell products. It focuses on a random set of products so it is rather 

creative to see what marketing strategies students can come up with. The key point to make in this exercise is that any two 

products can be related to each other and this can be used as material for marketing and cross selling. 

Objective 

Cross sell a pair of products while thinking of marketing strategy and advertisement approach. 

What You Need 

Small blank cards. 

Setup 

 Make the cards available to all students. 

 Explain that in this exercise, students will get to learn how to cross sell. 

 First they would need to select a number of products. Ask the students to pick around 20 products 

together. For example, if you have 8 students, each student  should pick three cards and write the 

name of one product on each. The teacher will end up with 24 products in this case. 

 Allow one minute for this. 

 Collect all the cards and check for duplicates. Ask the students to add more products if needed. 

 Keep the pile of cards (master pile). 

 Now, give one card to each student. Ask students to pair up with another person at random. If you 

have an odd number of students use a group of three. 

 Ask the groups to relate their products with an aim to cross sell them. How would they market the 

products together? How can one product be used to support the sale of the other? What 

advertisement strategies would they employ? 

Allow 15 minutes for this part. 

Collect half the cards and put them aside. 

Give a fresh card from your master pile to each person who doesn’t currently have a card. 

Now ask the students to repeat the exercise. Encourage students to talk to a different person than they did in the first 

round. 

Ask students their experiences one by one and explain what was most interesting in this activity?  

Allocate about 15 minutes for this part. 

Follow with a discussion to wrap up a number of grand conclusions or actions. 

Timing 

Explaining the Exercise: 2 minutes 
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Activity: 3 min selecting a unique set of products + (15 min cross selling * n rounds) + 15 minutes sharing experiences = 48 

minutes for two rounds 

Group Feedback: 5 minutes 

Discussion 

Did the students find a plausible strategy to cross sell all products? Was there any product that proved to be very difficult 

to cross sell? Why? Was there a surprising product that on the outset did not feel possible to cross sell but with further 

thought you came up with an elegant marketing strategy? 

 

Summary : A classroom environment relies heavily on the quality of communication taking place within it. As an instructor, 

taking steps towards improving the communication skills of your students will contribute positively towards your classroom 

climate. Students with effective communication skills will be more likely to contribute to class discussions, will be more 

productive members in group projects, and will ultimately gain more from their experience in the class. Learning and 

practicing writing skills help students to handle professional and social tensions.  

 

References 
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The basic and important aspect of self - management is physical appearance, grooming, mannerisms and 

etiquettes of a person. This creates first image in the mind of people about others. 

Impressive appearance and grooming  

Impressive appearance and well-groomed behaviour reflect our preparedness to handle the world around 

us. God has blessed us with this beautiful life and our body. It is our utmost responsibility to respect the 

almighty by keeping and presenting our body in best of shape. It all starts with oneself. You give respect 

and care to yourself; others will also give importance to you. Let’s look at the meaning of impressive 

appearance and grooming. Impressive appearance means having the ability to impress the mind, arousing 

admiration, awe, respect for the way someone looks or carries oneself. Grooming refers to the things 

people do to keep themselves neat and presentable. Proper grooming and impressive appearance are 

important to gain not just positive impression but also respect in the society. 

 

Importance of dressing appropriately, looking decent and positive body language 

Dressing appropriately, looking decent and positive body language all create a positive first impression. 

Dressing appropriately reflects the role that one plays. As a student studying in school, one is supposed to 

wear neat and ironed school uniform. Same uniform will be inappropriate if worn in a party or during 

family picnic or in swimming pool. When one dresses appropriately and keeps oneself neat, he/she 

conforms to generally acceptable standards of respectable and decent looks. Looks, gestures and postures 

comprise body language. A positive body language uses respectful, decent, non-offensive and appropriate 

expressions and body movements. 

Following points highlight the importance of dressing appropriately, looking decent and positive body 

language. 

 Promotes self-respect 

 Boosts self-confidence 

 It’s a step to overall improvement 

 It shows your attention to detail 

 Every expression leaves an impression 

 Your attire speaks before your words 

 Draws the right kind of attention and sends the right message 

 

Personal grooming checklist 

 

We have already seen the importance of well-groomed individuals. Following is the personal grooming 

checklist that you should strictly follow. 

 Maintaining health by seeing a doctor when necessary. 

 Maintaining health by eating well-balanced diet. 

 Maintaining health by using good posture. 

 Bathing or shower every day. 

 Shampooing the hair regularly. 

 Styling hair in a neat (away from my face and off my collar) manner. 
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 Brushing teeth regularly (at least twice daily). 

 Trimming fingernails and keeping them clean. 

 Wearing properly fitted clothes. 

 Donning clean and ironed  clothes. 

 Changing socks and stockings daily to reduce foot odour. 

 Avoiding wearing jewelry or perfume with uniform. 

 

  self-exploration techniques 

 

Every now and then we examine and analyze the goals we want to achieve in life and the necessary 

resources we need to realize them. Self- exploration refers to knowing one’s potential by examining and 

analyzing intellectual and spiritual capacities. Self-exploration helps develop a clear understanding of 

self-interests, attitudes, skills, wants and needs, which guide you to choose your profession for life. It also 

helps in identifying the goal of life that we wish to pursue. Self-exploration journey is as beautiful as its 

destination. Following approaches may help people self- explore.  

 Learning  

Formal / Informal/ Self-directed learning leads to acquiring some skills. Out of the learnt 

skills some skills may be preferred skills, and may guide us shape our career. An attitude 

of continuous learning helps us to update ourselves with the required skill set that keeps 

changing with the time. 

 Career Counsellor / computerized career information systems 

Career counsellor and career information systems can help one with information on 

courses and the outcome of the courses. 

 Self-reflection/ Inquiry 

This is a thoughtful process where people discover themselves through reflection on past 

experiences and patterns of their own behaviour.  

 Feedback 

Peers, family and mentors provide us with genuine feedback which help us identify our 

hidden talents and strengths.  

 

 

Team work skills  

 

Team refers to a group of people who have complementary skills and work towards a common goal. 

Common examples around us are of cricket team, volleyball team, team of doctors and nurses. Teams 

result in higher productivity. Teams are very useful in performing work that is complicated, complex, 

interrelated, and /or more voluminous than one person can handle.  

  

Important factors that influence team building 

 

Following are the factors which influence team building: 
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 Work Team Structure 

It includes goals and objectives, operating guidelines, performance measures, and role 

specification. 

 Work Team Process 

Work team competitiveness and cooperative behaviour need to be considered while 

building a team. 

 Diversity 

Diversity influences team building as well as effectiveness. Diversity shall be ensured in 

gender, background and competencies. Diverse team also ensures creativity. 

Factors influencing team work 

 

Following factors may influence team work. 

 Team norms 

Team norms is the standards or rules that govern the performance of the group members. 

These rules can be written or unwritten.  

 Team cohesion 

Bonding between the group members will come easily and together they contribute to the 

larger goal. 

 Social loafing 

Social loafing or free riding occurs when one or more group members rely on the efforts 

of other group members and fail to contribute their time and effort. Identifying individual 

contribution can help nullify the effect of free riding. 

 Loss of individuality 

It is a social process in which individual group members lose self-awareness and its 

accompanying sense of accountability, inhibition and responsibility for individual 

behaviour.  

Time management strategies and techniques 

 

Time management is the process of planning and exercising control of time spent on various activities to 

increase efficiency and effectiveness. Time as a resource is the same for everyone. It is up-to us to make 

the best use of this resource.   

Following are  the set of activities we need to take up for time management 

 Setting and prioritizing goals 

We have option to steer our life or to let it run on its own. If we take charge of our life 

and our goals, we will be able to lead a meaningful life. For leading a successful life, we 

should create our targets and aims. This can only be achieved if we are able to set and 

prioritize our daily activities, which shall be aligned to our goals. 

 Creating a schedule 

Creating a schedule instills discipline and punctuality and ensure efficient utilization of 

our time. 
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 Making lists of tasks 

This should be our first to-do thing every morning. List of tasks shall be prioritized for 

making our day worthwhile.  

 Balancing work and leisure 

Work is important and equally important is leisure activity to help us unwind and 

recharge for the important tasks. 

 Breaking large tasks into smaller tasks 

We should break large tasks into smaller ones. Smaller tasks can be finished in lesser 

time. When we will finish few small tasks, we feel motivated to complete others too. 

 

 

Activities            

Session A. Demonstration of impressive appearance and groomed personality 

Session B. Demonstration of the ability to self-explore with the techniques mentioned. 

Session C. Group discussion on qualities of a good team and on strategies that are adopted for team 

building and team work 

Session D. Game on time management with checklist and to-do-list preparation on a given day. 
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Unit 1– CREATING A DOCUMENT IN WORD PROCESSOR 
 
 
1.1 INTRODUCTION TO WORD PROCESSING 
 
 Word processor is software that helps you type and work mainly with text on a computer. You can create a 
document like, letter, memo, and newsletter and save it in word processor. The main advantage of creating a 
document in word processor is that a document can always be reopened and edited. You can also format it, 
check and correct spellings and grammatical errors , insert drawings, images, and pictures, apply page 
borders, and also print it. 
 
1.2 SOFTWARE PACKAGES FOR WORD PROCESSING 
 
A variety of word processors such as Microsoft Word, Open Office Writer, and Star Office have been 
developed to make text input and editing on the computer easy. An online word-processing application such 
as Google Docs (part of Google Drive), is also becoming popular. 
 
 
 
 
 
 
Let us learn about Apache Open Office Writer, a popular Open source word processor.  
 
1.2.1 Apache OpenOffice  
 
Apache OpenOffice is a free and open-source software that has been developed by the Apache Software 
Foundation. Apache OpenOffice can be downloaded for free from:  
 
http://www.openoffice.org/  
 
It is available in a number of languages. It can also read/write files created in other Office software packages.  
 
The Apache OpenOffice package contains the following: 
• OpenOffice Writer (Word processor) 
• OpenOffice Calc (Spreadsheet) 
• OpenOffice Impress (Presentation) 
• OpenOffice Base (Database Management System) 
• OpenOffice Draw (Graphics) 
• OpenOffice Math (Equation Editor) 
 
In this chapter we are discussing version 4.1.5 of Apache OpenOffice. You regularly get updated versions of 
OpenOffice. The new version of Apache OpenOffice shows a sidebar on the interface of Writer, Impress, and 
Calc. It is similar to the ribbon in Microsoft Office, which is a paid version.  
 
 
1.3 OPENING AND EXITING WORD PROCESSOR 
 

Do you Know? 

“Word Processor” was the first most 

popular Word processing software. 
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Apache OpenOffice Writer is a word processor program, which is equivalent to MS Word. It is used for 
creating, editing, formatting, and printing text documents. You can include pictures, charts, tables, and can 
save the document in various formats.  
 
To start OpenOffice Writer, click Start  All Programs  OpenOffice 4.1.5  OpenOffice Writer. 
The Apache OpenOffice Writer window, along with its sidebar and other components, is shown in Figure 1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 1 Apache OpenOffice Writer window 
 
Title Bar  The title bar is placed at  top of the Writer window. It displays  currently opened document name 
followed by the program name. If you create a new document, it shows the name as Untitled 1, Untitled 2, 
etc. This is replaced by the filename you give when you save the document. To  right of the title bar, you can 
see three buttons: Minimize, (Restore Down)Maximize and Close. 
The Minimize button is used to reduce the window to a small icon on the taskbar. The Restore Down button 
is used to make the window smaller than full size. The same button is used to bring it back to full size. The 
Close button is used to close the window. 
 
Menu bar The Menu bar, which is displayed below the Title bar, has different options like, File, Edit, View, 
etc. Clicking on a menu option displays options of this menu. 
 
Standard Toolbar It is displayed below the Menu bar and contains buttons for the most commonly used 
commands, like, New, Open, Save, etc. 
 
Formatting toolbar This toolbar has buttons for the most commonly used formatting commands. 
 
Document Window The document window is used to create a document. This is the area where you can 
type text, insert pictures etc. 
 

Title bar 
Standard bar 

Formatting 

bar 

Vertical 

ruler 

Status bar 

Zoom control 

Minimize 
Maximize/Re

store Down 

Close 

Side bar 
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Scroll bars  The horizontal scroll bar is present at the bottom of the document window and is used to move 
the document left or right. The vertical scroll bar is present to the right of the document window and is used 
to move the document up and down. 
 
Rulers The horizontal ruler is present at the top of the document window and is used to set left and right 
margins. The vertical ruler is present to  right of the document window and is used to set top and bottom 
margins. 
 
Status bar The Status bar is present at  bottom of the Writer window. It displays information about the 
current document, such as number of pages, current page number etc. 
 
Zoom control The zoom level of the document can be set by clicking, holding, and dragging the slider. 
 
Let’s Try  
 
Start OpenOffice Writer. Identify various components of the OpenOffice Writer window: - Title bar, Standard 
bar, Formatting bar, Horizontal and vertical scroll bar, Horizontal and vertical ruler, Minimize, maximize and 
Close buttons, Status bar 
 
 
1.3.1 Opening a Document 
To open an already saved document in OpenOffice Writer: 
 

1. Click the Open option from the File menu. 
Or 
Click the Open (Fig 2) button on the Standard bar. 
 
 
 
 
 
 
Fig 2 Open button on the Standard bar 
 

Or 
 

Press Ctrl + O. 
2. The Open dialog box appears. 
3. Select the Drive and the folder. 
4. Select the file and click Open button. 

 
 
1.3.2 Closing a Document 
To close an open document, click the Close option from the File menu. 
 
1.3.3 Exit Writer 
To exit Writer, click the Exit option from the File menu. 
 

Open button 
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1.4 CREATING A NEW DOCUMENT 
To create a new text document in OpenOffice Writer: 

1.  Select File  New  Text Document. (Fig 3) 
 

 
 
Fig 3   New option of File menu 
 
 
Or 
 
Click New button on the Standard toolbar (Fig 4) and select the desired option  to create a new text 
document. 
 
 
 
 
 
 
 
Fig 4 New button on the Standard toolbar 
 
Or 
 
You can also press Ctrl + N on the keyboard to create a new document. 
 
 
1.5 Saving a Document 
To save a document,  

1. Click the File menu. 
2. Select Save As option . (Fig 5) 

New Button 
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Fig 5 “Save as”  option of File menu 
 
Or 
 
Click the Save button on the Standard bar as shown in Figure 6. 
 
 
 
 
 
 
 
Fig 6  Save button on the Standard toolbar 
 

3. The Save As dialog box appears. (Fig  7) 
4. Select the location where you want to save the document. 
5. Type the file name, and click on the Save button. Documents created and saved in Writer have the 

extension .odt by default. 
 
 

Save button 
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Fig  7 Save As dialog box 
 
 
 
 
 
 
 
 
 
Let’s Try it  
 
 
Teacher can discuss with the students about  earlier Typewriter which  was used for typing. But there were 
some limitations of using a typewriter. Discuss the limitations and ask the students to  create a document 
and type these limitations. Also, the teacher can discuss about electronic typewriters, which used to print 
one line of typing at a time. 
 

1. Start OpenOffice Writer. 
2. Create a new document. 
3. Type a paragraph about limitations of using typewriter. A sample is given below: 

 
 
 
 
 
 
 
 

Limitations of Using Typewriter 

If there was some error while typing using typewriter, 

correction could not be done and entire sheet had to be 

typed again. Also, if same document or letter was to be 

sent  to different people , then it had to be typed again 

and again. The formatting of the text was also not 

possible when document was typed using typewriter. 

Keyboard Shortcut 

Save   Ctrl +S 

Save As  Shift + Ctrl + S 
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4. Save the document with name ‘typing’. 
5. Close OpenOffice Writer. 

 
Let’s Try it  
 
Now, discuss the advantages of using word processor, and ask the students to perform the following tasks on 
computer.  
 

1. Start OpenOffice Writer. 
2. Open the already saved document ‘typing’. 
3. Now add another paragraph about advantages of using word processor. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Save the document. Which option will you select to save the file with the same name –Save or Save 

As? 
5. Close the document. 
6. Exit from Writer. 

 
Let’s Try It  
 

1. Create a new document in Writer. 
2. Type a paragraph mentioning use of word processor for students, teachers, in business etc. 

Hint: You can mention that students can do assignments, type project reports in word processor. 
Teachers can prepare assignments, question papers etc. In offices, word processor can be used for 
preparing reports, writing letters, etc. 

3. Save the document as ‘word processor’. 
 
Worksheet 1 
 

1. Name the two toolbars.  ____________  ________________  

Advantages of Word processor 

The document created on computer using word processor can be saved 

and edited. The document remains saved until we delete it. The text can 

be formatted to enhance its appearance like, you can change the font, 

size and color of the text. You can also highlight important words. If 

there is some error, the document need not be typed again, corrections 

can be done in the same document. You can also check the spelling and 

grammatical mistakes. The document can be printed any number of 

times. You can insert pictures and graphs in a document. You can insert 

different shapes etc. 
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2. Name the toolbar used to scroll the document up and down ________  
3. Name the bar present at  bottom of the Writer window that gives information about  number of 

pages in the document. __________  
4. Name the two rulers ____________  ______________  
5. Name the ruler that is used to set  left and right margins __________  
6. Name the bar that has buttons for  most commonly used commands ______   
7. Name the three buttons present to  right of the Title bar. ______  
8. Name the button used to reduce the window to a small icon on  taskbar. _____________  
9. Which action/button is used to make the window smaller than full size? ___________  
10.  Mention any two features of word processors. 

___________________________  
___________________________ 
 
Worksheet 2 

1. Dhruv has to type his project report. Name the software he can use for this purpose. 

__________________________  

2. Hiren has created a new document in Word processor. In which part of the word processor window, 

name of the document is displayed? 

3. Udhav wants to reduce the window size to a small icon on the taskbar, which button should he click 

– Maximize, Minimize, or Close? 

4. Which toolbar – Standard or Formatting contains the buttons for commands like, New, Save, Open, 

etc.? 

5. Piyush wants to check the number of pages in the document. Name the bar that displays this 

information. 

6. Riya has to check left and right margins. Which ruler- Horizontal or Vertical should she check? 

7. Mudit noticed “Page 1/2  “ displayed on the left of the Status bar. What do numbers 1 and 2 

represent? 

8. Name  three buttons present to the right of the Title bar. 

9. Gurpreet’s teacher told her that there are two scroll bars in Word Processor window. Name the 

scrollbar present at  bottom of the document window. 

10. Name any one online word processor. 

 
 
Worksheet 3 
 
 

1. Write Keyboard shortcuts for the following commands: 
i. New 

ii. Save 
2. Name the menu that has option to create a new document. 
3. What is the difference between “Save” and “Save As” options of File menu? 
4. Dhriti wants to open an already saved document in word processor. Since the mouse is not working 

properly, her teacher has asked her to use the keyboard shortcut. What is the keyboard shortcut for 
Open command? 

5. Sukrit has created a new document in word processor. Which option should he use – Save or Save 
As? 
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6. Udit opened an already saved document ‘My Story’. He made few changes in the document. To save 
the changes, which option should he use – Save or Save As? 
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Unit -2 – EDIT, SAVE AND PRINT A DOCUMENT IN WORD PROCESSOR 
 
2.1 EDITING TEXT 
 
As we already know that there are so many advantages of creating document in word processor. 
One of the main advantages is that we can make changes in the document whenever we want.  
Editing means making changes into existing text.  
But before editing or formatting the text, you may need to select the text. Selection of text can be 
done with the keyboard or the mouse. 
The selected text gets highlighted with blue color. 
OpenOffice Writer features various tools to edit text in a document.  
 
2.1.1 Selecting consecutive text 
 
You can select consecutive text using mouse or the keyboard. 
 Selecting Text Using a Mouse 
To select text using a mouse, follow the steps: 
1. Place the cursor to the left of the first character of the text to be selected. 
2. Press the left mouse button and drag the mouse to the position where you want to end selection. 
3. Release the mouse button. The selected text gets highlighted in blue color (Fig. 1). 
 

 
Fig 1      Selecting text 
 
 
 Selecting Text Using Keyboard 
You can select text using even the keys on your keyboard. First, place the cursor to the left of the 
first character you wish to select. Then use the following key combinations: 
To select      Key combinations 
One character to the left     Shift + 
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One character to the right    Shift +  
One line up       Shift + 
One line down      Shift + 
To the end of the current line    Shift + End 
To the beginning of the current line   Shift + Home 
To the end of the current document   Shift + Ctrl + End 
To the beginning of the document   Shift + Ctrl + Home 
Entire document      Ctrl + A 
 
 Selecting non-consecutive text items  
You can also select non-consecutive text in a word processor. (Fig 2) 
 

 
Fig 2   Selecting non-consecutive text 
To select non-consecutive text in a document using mouse: 

1. Select the first text. 
2. Press and hold down the Ctrl key. 
3. Select the next text. 
4. Repeat steps 2 and 3 for other text. 

 
Let’s Try 
 
Open an already saved document. Practice selecting a sentence, any word, a paragraph, and the 
entire document. (Practice using keyboard and mouse). Also try selecting non-consecutive words or 
text. 
 Inserting and Overtyping Text 
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You can insert (add) text into the existing text or overtype (replace old text with the new one) text 
in OpenOffice Writer.  
To insert text, press the Insert key, to turn ON the Insert mode, which is indicated by INSRT 
appearing on the status bar (Fig. 3). 
 
 
 
 
 
 
 
 
 
Fig. 3      INSRT on the status bar 
 
Sometimes, you may need to type and replace the current text. This can be done using the 
Overtype mode. To overtype text, press the Insert key or click on INSRT on the status bar to turn 
ON the Overtype mode, which is indicated by OVER appearing on the status bar (Fig. 4) 
 
 
 
 
 
 
 
 
 
 
Fig. 4    OVER on the status bar 
 
 Inserting a Blank Line 
You can also insert a blank line between two existing lines. The steps are: 
 
1. Place the cursor at the end of the line after which you want to insert a blank line. 
2. Press Enter. You will notice that the next line gets shifted down and a blank line is inserted. 
 
 Deleting Text 
You can easily delete a character word, or a block of text in OpenOffice Writer. Let us learn how to 
delete a character, block of text or a word. 
 
To delete a character, the steps are: 
1. Position the cursor to the left of the character to be deleted. 
2. Press DELETE. 
Or 

INSERT mode selected 

on the Status bar 

OVER mode selected on the 

Status bar 
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1. Position the cursor to the right of the character to be deleted. 
2. Press BACKSPACE. 
 
To delete a block of text, the steps are: 
1. Select the text to be deleted. 
2. Press DELETE or BACKSPACE. 
 
To delete a word, the steps are: 
1. Place the cursor to the left of the word to be deleted. 
2. Press Ctrl + Delete. 
Or 
1. Place the cursor to the right of the word to be deleted. 
2. Press Ctrl + Backspace. 
 
 Undo and Redo Commands 
The Undo command is used to reverse the last command/action. 
To reverse the last action, click the Edit button and then click Undo in the drop-down menu. (Fig 5) 
Or 
Click the Undo  button on the Standard bar. (Fig 6) 
 
 

 
 
Fig 5    Undo option of Edit menu. 
 
 
 

Undo  

Undo button Redo button 
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Fig 6    Undo button on the Standard toolbar 
 
 
The Redo command is used to reverse the last Undo action. To apply this command, click the Redo 
option from the Edit menu. 
Or 
Click the Redo  button on the Standard bar.(Fig 6) 
 
Note: As long as there is nothing to redo, the Redo command will 
show up as Repeat command. The function of the Repeat 
command is to repeat the last thing you did in OpenOffice Writer. When you 
undo an action, the Repeat command changes to Redo. 
 
 
 
 
 
 
 
 
 
 Copying Text 
You can easily copy text from one place to another in a document. For this purpose, you will have to 
use Copy and Paste commands. The Copy command creates a duplicate of the selected text and the 
Paste command pastes the copied text at  position where the cursor is placed. 
 
To copy text from one location and paste it at another location, the steps are: 
1. Select the text to be copied. 
2. Click the Copy option from the Edit menu. 
Or 
Click the Copy  button on the Standard bar. (Fig 7) 
3. Position the cursor at the location where you want to paste the text. 
4. Click Paste option from the  Edit menu. 
Or 
Click the Paste button on the Standard bar. (Fig 7) 
 
 
 

Cut 
Copy 

paste 

Keyboard Shortcut 

Undo   Ctrl + Z 

Redo   Ctrl + Y 
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Fig 7    Standard bar 
 
 Moving text 
You can easily move text from one position to another using Cut and Paste commands. The steps to 
move text from one location to another are: 
 
1. Select the text to be moved. 
2. Click the Cut option from the Edit menu.  
Or 
Click the Cut  button on the Standard bar. (Fig 7) 
3. Position the cursor at the location where you want to paste the text. 
4. Click Paste option in the Edit menu or Paste button on the Standard bar. 
 
 
 
 
 
 
 
 
 
 
 
 
Let’s Try 
 
Open an already saved document in Writer and practice deleting text using Delete key, backspace 
key. Also practice copying and moving text. 
 
 
2.2 WRAPPING and ALIGNING TEXT 
 
2.2.1 Wrapping Text 
 
Text wrapping is a feature that automatically starts a new line when a word in a sequence reaches 
the border of a picture, a text box, or the margin. There are different options to wrap text around 
the image. The steps are: 

1. Select the image. 

Keyboard Shortcut 

Copy  Ctrl + C 

Cut  Ctrl + X 

Paste  Ctrl + V 
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2. Select Wrap option from the Format menu. 
a. Select the desired option. 

 
2.2.2 Setting Alignment 
Alignment is the manner in which text is placed within the margins of a page. Alignment is used to 
create attractive, and readable pages in a document. Proper alignment makes the document 
visually appealing and easier to read.  
 
The steps to change the alignment of text are: 

1. Select the text.  
2. Select Paragraph option from the Format menu. 
3. The Paragraph dialog box appears. (Fig 8). 

 
 

 
Fig  8 Alignment tab of Paragraph dialog box 
 

4. Select the desired alignment option. 
5. Click OK. 

 
Or 
 
You can click a desired alignment button on the Formatting bar (Fig 9) 
 
 
 
 
 
 
 
Fig. 9   Alignment buttons on the Formatting bar 
 

Left Align 

Center Right Justify 
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Or 
Click the Format menu and then click Alignment in the drop-down menu 
(Fig. 10). Select the desired option from the submenu. 
 
 

 
 
Fig. 10 Alignment option in the Format menu 
 
 
Let’s Try 
 
Open an already saved document in writer. Also try different alignment options. 
 
2.3 FONT SIZE, TYPE AND FACE 
 
Another advantage of word processor is that we can change the appearance of the text by changing 
the size, color and style. Formatting is the process of changing the appearance of the text in a 
document through  use of various fonts, font colors, font sizes etc. 
 
Some settings are pre-defined in Writer. These pre-defined settings in a software are called default 
settings. You can also make changes in the default settings.  
 
The font size or text size is the overall size of a character shown on the computer screen or the 

printed page. A font is typically measured in unit called point (pt). There are approximately 72 

points in one inch or 2.54 cm. 

Font style refers to whether the font or text is displayed in bold, italics, underlined or normal. We 

can apply more than one style to the characters.eg – bold,bold, bold,bold etc. 
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A typeface is a style of lettering. For example, Times New Roman is a typeface. 

A font is a specific size and style of a typeface. For example,  Times New Roman Bold’ is a font 14 is 

size. Each style of font (Arial, Callibri, etc. are stored in a separate font file. 

 

2.3.1 Formatting Text 
Text formatting can be done either by using the Format menu or by using the Formatting toolbar. 
 
 Text Formatting Using the Format Menu 
1. Select the text. 
2. Click the Format menu bar and then select Character option. The Character dialog box appears. 

 You can change the font, font size, and typeface using the Font tab in 
the dialog box (Fig. 11). 

 Click on the Font Effects tab to change the font color, font effect, and apply other styles 
such as underlining (Fig. 12). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 11 Font tab of the Character dialog box 
 
 

Select Font Select 

Typeface 

Select Font 

size 
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Fig. 12 Font Effects tab of the Character dialog box 
 

 You can change  position of the text (e.g., superscript, subscript, etc.) using the Position tab 
(Fig. 13). 

 

 
 
Fig. 13 Position tab of the Character dialog box 
 
3. Click OK after choosing the desired options. 
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 Text Formatting Using the Formatting Bar 
The Formatting bar has various buttons on it, as shown in Figure 14. These buttons can be used for 
formatting text. 
 
 
 
 
 
 
 
Fig. 14 Formatting bar 
 
 
Keyboard Shortcuts 
 
Bold   Ctrl + B 
Italic   Ctrl + I 
Underline  Ctrl + U 
 
2.3.2  Change Case 
 
Sometimes you type the entire text in upper case and after typing you realize that it should have 
been in lowercase or vice - versa. You need not type the entire text again but use the Change Case 
option to change the case of text. The steps are: 
 
1. Select the Change Case option from the Format menu. (Fig. 15). 
2.Select the desired option in the submenu. 

Sentence case   The first character in a sentence is capitalized and the rest are in 
lowercase. 
lowercase   All characters are in lowercase (small letters) 
UPPERCASE   All characters are in uppercase (capital letters) 

Capitalize Every Word  The first character of each word is capital and the rest are in 
lowercase 
tOGGLE cASE   Changes lowercase characters to uppercase and 

uppercase characters to lowercase 
 

Select Font Font  

Size 

Bold 
Italic 

Underline 

Text 

Colour

rr 

Highlighting 
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Fig. 15 Change Case option in the Format menu 
 
Let’s Try 
Open an already saved document in Writer. Try different Change Case options. 
 
Let’s Try  
 

1. Start OpenOffice Writer. 
2. Create a new document and type the following text: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Secrets of Maintaining Good Health 

We can keep good health by having good eating habits. We should take  balanced diet in accordance 

with planned timings. 

We should ensure that our meal incorporates the five food groups: cereals and grains, pulses and 

legumes, fruits and vegetables, milk and meat products, nuts and oils. 

We should drink at least two liters of water every day to maintain the water balance of the body, 

flush out toxins and prevent dehydration. 

Oil, ghee, butter are actually healthy, but we should minimize their use.  Healthy alternatives like 

steaming, boiling, roasting etc. should be adopted in cooking. 

For best results, include regular exercise, regular check-ups, positive thinking, yoga and meditation. 
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3. Select the second paragraph using the mouse. 
4. Now, make a copy of the selected paragraph at the end of the document. 
5. Undo the last action. 
6. Format the text according to the following specifications: 

a. Heading should be in Comic Sans MS font and font size 16. 
b. Paragraph text should be in Times New Roman font and font size 14. 

 
7. Save the file as ‘good health’. 

 
Final document will appear as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Worksheet 
 

1. Madhur wants to make a copy of the paragraph he has typed in the document. Name the 
set of commands he should use to make a duplicate of the selected text.  
____________________  

2. Pranav has typed the paragraph at wrong position. Write the set of commands used to 
move the text from one position to another in a document. 
_____________________  

3. Write keyboard shortcut for the following commands: 
a. Copy 
b. Cut 
c. Paste 
d. Undo 

Secrets of Maintaining Good Health 

We can keep good health by having good eating habits. We should take a 

balanced diet in accordance with planned timings. 

We should ensure that our meal incorporates the five food groups: cereals and 

grains, pulses and legumes, fruits and vegetables, milk and meat products, nuts 

and oils. 

We should drink at least two liters of water every day to maintain the water 

balance of the body, flush out toxins and prevent dehydration. 

Oil, ghee, butter are actually healthy, but we should minimize their use.   

Healthy alternatives like, steaming, boiling, roasting  etc. should be adopted in 

cooking. 

For best results, include regular exercise, regular check-ups, positive thinking, 

yoga and meditation. 

 

For best results, include regular exercise, regular check-ups, positive thinking, 

yoga and meditation. 
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4. Vedika has to make the important words darker than  normal text. Which command of word 
processer can she use to make the text darker than  normal text? What is the keyboard 
shortcut for this command? 
____________________  

 
5. Sukrit has typed a document in word processor. He wants to make entire text in the 

document bold. How can you select entire document using the keyboard? 
______________________  

6. Name the command used to reverse   previous action. 
_____________________________  

7. Name the menu that has option to change the text color and size. 
_______________________________  

 
 
2.4  HEADER AND FOOTER 
 
Header is the text that is printed at the top of each page (in the top margin) in a document. Footer 
is printed at the bottom of each page (in the bottom margin). 
Header and Footers provide additional information about the document, like, date, page number, 
etc. 
To insert headers and footers in a document; 
 

1. Select Insert  Header or Footer  Default. 
The header area appears at the top of the document. (Fig 16) Type the header. 

Or 
Select Page option from the Format menu.  

a. The Page Style: Default dialog box appears. 
a. Click the Header tab (Fig. 17) or the Footer tab (Fig. 18). 
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Fig 16 Typing Header 
 
 
 

 
 
Fig. 17 Header tab of the Page Style: Default dialog box 
 

 
 
Fig. 18 Footer tab of the Page Style: Default dialog box 
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c. A box will appear at top and the bottom area of  page, respectively (Fig. 19). 
You can either type text or add date and time by selecting the Fields option in the 
Insert menu. 
4. Click in the document area to finish adding header or footer information. 

 
 
 
 
Fig. 19 Inserting header 
 
2.4.2 Removing Header or Footer 
 
To remover header of footer, the steps are: 

1. Select Insert   Header or Footer    Default. 
2. A message box appears (Fig 20). 
3. Click Yes to delete the header or footer. 
 

 
 
 
Fig 20 Message box 
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2.5 AUTOCORRECT 
 
One of the main advantages of creating a document in word processor is that we easily come to 
know about  spelling and grammatical mistakes done while typing. These can be easily corrected 
using the options available in word processor. While typing in an OpenOffice Writer document you 
will notice red or blue wavy lines under the text. A red wavy line indicates a misspelled word, and a 
blue wavy line indicates spacing error, misused word or  grammatical mistake. 
 
OpenOffice Writer provides the following two ways of checking spelling and grammar in a 
document: 
• Using AutoSpellcheck 
• Using the Spelling and Grammar option 
 
2.5.1 Using AutoSpellcheck 
The steps to check spellings as you type are: 
1. Click the AutoSpellcheck button on the Standard bar (Fig. 21). 
2. Right-click the misspelled word (with a red wavy underline) and then choose a word from the 
suggested list  
or  
from the AutoCorrect submenu (Fig. 22). 
If you choose a word from the AutoCorrect submenu,  misspelled and the replacement words are 
automatically added to the AutoCorrect list for the current language. 
 
 
 
 

 
 
Fig 21 AutoSpellcheck button on the Standard bar 
 

AutoSpellcheck 

button 
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Fig 22 AutoCorrect submenu 
 
2.5.2  Using the Spelling and Grammar Option 
The Spelling & Grammar option of OpenOffice Writer helps you check the spelling and grammatical 
errors in your document. The steps are: 

1. Select the Spelling and Grammar option from the Tools menu. 
Or 

Click the Spelling and Grammar button on the Standard bar. (Fig 23) 
   Or 
 Press F7 

2. The Spelling dialog box appears (Fig. 24).  
a. The unrecognized word is displayed in the Not in Dictionary text box and  

suggestions are displayed in the Suggestions box. 
b.  On clicking the desired button,  respective action takes place and the next word is 

highlighted.  
c. Repeat this step until a message box saying “The spell check is complete” is 

displayed. (Fig 25) 
3. Click OK. 
 
 
 

Spelling and 

Grammar option 
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Fig 23  Spelling and Grammar button on the Standard bar 
 

 
Fig. 24 Spelling dialog box 
 

 
Fig 25 Message box 
 
 
2.6 NUMBERING AND BULLET 
 
A list is a way of organizing items in a document. This helps the reader to understand  key points 
easily. Lists can be created for step-by-step instructions to a series of points. Word processor has 
option to create numbered or bulleted list.  
 
A numbered list is created if the order of items is very important. A numbered list is also called as 
ordered list. You can use different numbering styles – numbers, roman numbers, or alphabets to 
mark the items in a numbered list.  
 
A bulleted list is used when order of items is not very important. This is also known as unordered 
list. A bullet or symbol is used to mark the items of the list. For example, let’s create a list of items 
to be purchased for your birthday party. Since the order of these items is not important, it can be a 
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bulleted list. But, if you use numbers or alphabets to mark these list items, then it will become a 
numbered or ordered list. 
 
To create a bulleted or numbered list, do as follows: 
1. Place the cursor at the position where you want to start the list. 
2. Select Bullets and Numbering option from the Format menu. 
3. The Bullets and Numbering dialog box appears. 
4. Click the Bullets tab (Fig. 26) or the Numbering type tab (Fig. 27).  
5. Choose the desired style and click OK. 
 
 

 
 
Fig. 26 Bullets tab of the Bullets and Numbering dialog box 
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Fig. 27 Numbering type tab of the Bullets and Numbering dialog box 
 
You can also create lists using the Bulleted list button or the Numbered list button on the 
Formatting bar. (Fig 28) 
 
 
 
Fig 28  Formatting bar 
  
Let’s Try 
 
Create a document in Writer and type a bulleted list of festivals celebrated in your country. Give 
heading as ‘List of Festivals’. Also choose suitable font, size and color for the list text and heading. 
 
Let’s Try 
 
Create a new document in Writer and type the following list. 
 
 
 
 
 
 
 
 
 

Numbering Bullets 

 

1. Operating System 

a. Windows 8 

b. Windows 10 

2. Microsoft Office 

 MS Word 

 MS PowerPoint 

 MS Excel 
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2.7 CREATING TABLE 
 
Tables in a document can be used to present information. It is easier to read or present information 
in a tabular format.  A table is arrangement of data arranged in rows and columns. Word processor 
uses tables to place information into rows and columns. Your class Time Table is an example of a 
table. 
A column is a vertical series of cells in a table. 
A row is a horizontal series of cells in a table. 
The intersection of row and column forms a rectangular box called cell. 
 
 
 
 

   

   

   

 
 
 
 
 
Tables can be created in OpenOffice Writer in any one of the following ways: 

 Using Table button 

 Using Table menu 
 
2.7.1 Creating a Table Using the Table Button 
The steps to create a table using the Table button are: 

1. Click the drop-down menu arrow of the Table button on the Standard bar. 
2. A grid of cells appears. Move the mouse pointer in the grid to highlight the 

number of rows and columns required in the table (Fig. 29). 
1. A table will be inserted at the insertion point. 

 
 
 
 
 
 
 
 
 

Cell 

Rows 

Columns 

Table button 
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Fig. 29 Table Button 
 
 
2.7.2 Creating a Table Using the Table Menu 
The steps to create a table using the Table menu are: 

1. Select Table  Insert  Table. 
Or 

Press Ctrl + F12. 
Or 

         Select Insert   Table 
2. The Insert Table dialog box appears.  

a. Specify the number of columns 
b. Specify the number of rows 

2. Click OK 
 
 
2.7.3 Entering data in a cell 
 
To enter data in a cell, click in the cell and then type the text. 
 
2.7.4 Selecting row or column 
 
To select a row or a column, click and drag the mouse button. 
 
2.7.5 Inserting/Deleting Rows/Columns 
 
A table can be modified by inserting or deleting rows or columns, and by merging or splitting cells. 
 
 Inserting Rows  
You can easily insert (add) new rows in a table in a Writer document. The steps to insert rows in a 
table are: 
1. Position the cursor in the cell where you want to insert a new row or a column. 
2. Select Table  Insert  Rows. 
3. The Insert Rows dialog box appears (Figs. 31). 
 a. Specify the number of rows to be inserted. 
 b. Select the position – Before or After the selected row. 
 c. Click OK. 
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Fig. 31 Insert Rows dialog box 
 
 
 Inserting Columns 
Columns can also be inserted in a document. The steps to insert columns in a table are: 
1. Position the cursor in the cell where you want to insert a new column. 
2. Select Table  Insert  Columns. 
3. The Insert Columns dialog box appears. 
 a. Specify the number of columns to be inserted. 
 b. Select the position – Before or After the selected column. 
 c. Click OK. 
 Deleting Rows  
To delete rows in a table: 
1. Select the rows to be deleted. 
2. Select Table  Delete  Rows. 
 
 Deleting Columns 
To delete columns in a table: 
1. Select the columns to be deleted. 
2. Select Table  Delete  Columns. 
 
 Merging the Cells of  table 
You can also merge (combine) cells in a table. The steps are: 
1. Select the cells to be merged. 
2. Select Table  Merge cells. 
 
 Splitting the Cells of the table 
You can split (divide) a cell into required number of rows or columns. The steps are: 
1. Click in the cell to be split. 
2. Select Table  Split Cells. 
3. The Split Cells dialog box appears (Fig. 32). 

a.  Enter the number of parts in which you want to split the selected cell. 
b. Specify the direction—Horizontally or Vertically—in which you want to split the cell. 



25 ICT- XI 

 

a. Click OK. 

 
 
Fig. 32 Split Cells dialog box 
 
 
 Applying Borders and Background to the table 
You can apply borders and background color to the entire table or selected cells of the table. The 
steps to apply borders and background to a table are: 
1. Select the table or rows/columns/cells. 
2. Select Table Table Properties. 
3. The Table Format dialog box appears  

a. Click the Borders tab (Fig. 33). Select the line style and line color. 
b.  Click the Background tab.(Fig 34). Choose the desired background color. 
c. Click OK. 
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Fig. 33  Borders tab of Table Format dialog box 
 
 

 
 
Fig. 34 Background tab of Table Format dialog box 
 
 
Let’s Try! 
 

1. Ishani was asked to create a document and give details of students who won prizes in 
various competitions. She has created the following document. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 Can you present this information in a tabular form to make it more presentable and easily 
readable? 

Senior Secondary Department  

 

Zonal Level (Group) 

Aryan  XI A 1st position   Nukkad Natak Competition 

Akshit               XI A 1st position   Nukkad Natak Competition 

Riya  XI F 1st Position Stage Play  

Vasu        XI F 2nd Position Hindi Debate   

Sarthak    XI D 1st Position Hindi Extempore  
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2. The class teacher wants to keep record of students’ marks. She has asked Sidharth to design 

the following sheet in word processor. Can you design the same sheet in word processor? 
 
 
Evaluation Record 
 
Class and Section ____________________ 

 

Roll 
No. 

Name of 
the 
Student 

Evaluation Record 

          

          

          

          

          

          

          

 
 
 
2.8 FIND AND REPLACE 
 
Sometimes you may need to search a word or text in a document and replace it with another word 
or text. The Find option is used to search a word or text in a document and Replace command is 
used to replace the specific word or text in a document. 
The Find & Replace feature of OpenOffice Writer can be used to find a particular word or text in a 
document, or to replace a word or text in a document. 
 
2.8.1 Finding Text 
The steps to search a word or text in a document are: 

2. Select Find & Replace option from the Edit menu. 
3. The Find & Replace dialog box appears. (Fig 35). 

a. Type the word to be searched in  “search for” box. 
b. Click the Find button to locate the word one by one.  

Click the Find All button to highlight the word at all locations in the document. 
 

4. When the search is finished, click Close button. 
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Fig 35 Find & Replace dialog box 
 
 
2.8.2 Finding and Replacing Text 
You can search a given word and replace it with another word in a document. The steps to find and 
replace a word or text are: 

3. Select Find & Replace option from Edit menu 
4. The Find & Replace dialog box is displayed. (Fig 36) 
b. Type the word to be searched in  Search for box.  
c. In the Replace with box, type the word or text with which you want to replace the word or 

text typed in the Search for box. 
d.  Click the Replace button to replace the word one by one, or click the Replace All button to 

replace the word at all locations in the document. 
 

5. When all the occurrences of the word are replaced, a message box will appear. Click No to 
discontinue and close the Find & Replace dialog box. (Fig 37) 
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Fig 36 Find & Replace dialog box 
 

 
 
Fig 37 Message box 
 
 
2.9 PAGE NUMBERING 
 
You can add page numbers in the header or footer area. The steps are. 

1. Click in the header or footer area. 
2. Select    Insert  Fields   Page Number. 
 

2.10 PRINTING DOCUMENT 
 
To print a document, do the following: 
1. Select Print option from File menu. 
Or 
Click the Print button on the Standard bar.(Fig 37) 

3. The Print dialog box appears (Fig. 38). 
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a. Select the printer. 
 

b. Specify the range of pages to be printed. 
c. Specify the number of copies to be printed. 
d. Click the Print button 

 
 
 
 

 
 
Fig 37 Print button on Standard bar 

 
Fig. 38  Print dialog box 
 
2.11 SAVING A DOCUMENT IN DIFFERENT FORMATS 
 
You have already learnt how to save a document in OpenOffice Writer. If you want to save a file in a  
format other than the default format .odt of OpenOffice Writer. The Steps are: 

1. Select Save As option of File menu. 
2. The Save As dialog box appears.(Fig 39) 

a. Select the File type from the Save as type drop-down list. 
b. Type the filename. 
c. Click Save button. 

Print 
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Fig 39  Save As dialog box 
 
 
 
 
 
 

 
Let’s Try it  
 

a. Design an advertisement for the ‘ABCD Personality Centre giving necessary details. Run spell 
check to check spelling mistakes. You can also insert suitable picture in the document. A 
sample is given below: 

 
 
 
 
 
 
 
 

 
 
 

ABCD Personality Development Centre 

New Delhi 

Join the centre for overall personality growth. 

The centre holds classes on: 

 English Speaking 

Do you know? 

When you create and save a document in MS Word, the filename has extension .docx 
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Let’s Try it  

1. Create a new document in OpenOffice Writer. 
2. Type an essay on the topic ‘Pollution’. 
3. Insert page number as footer and ‘Pollution’ as header. 
4. Use autocorrect to correct the spelling mistakes. 
5. Save the document in .doc format so that it can be opened in Microsoft Word also. 

 
Let’s Try it  
 

1. Create a new document in OpenOffice Writer. 
2. Design your class time table. 
3. Format the text in the table. 
4. Apply border to the table and shading to the cells of the table. 

 
Worksheet 
 

1. Write keyboard shortcut for the following commands: 
a. Spelling and grammar option   ___________  
b. Find and Replace   ______________  

2. Name the menu that has option to change the alignment of text in a document.   
_________________________   

3. Name the four alignment options. 
__________________   
__________________  
_________________  
_________________  

4. The intersection of row and column in a table is called a ________. 
5. What is the name given to the text printed on top of each page of a  document?   

___________  
6. What is the name given to  text printed at the bottom of every page in a document? 

__________  
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7. AutoSpellcheck option is available on ___________ bar. 
8. A ________ list is used when the order of items is important. 
9. The default bullet style is ________________. 

 
Worksheet 2 
 

1. By mistake, Sooraj has typed the entire document in small letters. Which option of Change 

Case  will he use if he wants to have only first character in capital and rest in small letters in 

a sentence? Name the menu that has the Change Case option. 

2. Identify the case of the following sentence: 

You Need Not Type The Entire Text Again. 

3. While typing  an article in Writer, Yuvan noticed red or blue wavy line under some text. 

What do red and blue wavy lines indicate? 

4. Yatish wants to search a word ‘morning’ in the document and replace it with ‘evening’. 

Name the feature of word processor that he can use for this purpose. 

5. Pooja has created a list with list items marked with symbol dot. Which type of list is this? 

6. You cannot apply border to selected cells in a table (True/False). 

7. Oorja wants to print page number at the bottom of every document. Which feature of 

Writer can she use for this purpose? 
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Unit 1– CREATING A DOCUMENT IN WORD PROCESSOR 
 
 
1.1 INTRODUCTION TO WORD PROCESSING 
 
 Word processor is software that helps you type and work mainly with text on a computer. You can create a 
document like, letter, memo, and newsletter and save it in word processor. The main advantage of creating a 
document in word processor is that a document can always be reopened and edited. You can also format it, 
check and correct spellings and grammatical errors , insert drawings, images, and pictures, apply page 
borders, and also print it. 
 
1.2 SOFTWARE PACKAGES FOR WORD PROCESSING 
 
A variety of word processors such as Microsoft Word, Open Office Writer, and Star Office have been 
developed to make text input and editing on the computer easy. An online word-processing application such 
as Google Docs (part of Google Drive), is also becoming popular. 
 
 
 
 
 
 
Let us learn about Apache Open Office Writer, a popular Open source word processor.  
 
1.2.1 Apache OpenOffice  
 
Apache OpenOffice is a free and open-source software that has been developed by the Apache Software 
Foundation. Apache OpenOffice can be downloaded for free from:  
 
http://www.openoffice.org/  
 
It is available in a number of languages. It can also read/write files created in other Office software packages.  
 
The Apache OpenOffice package contains the following: 
• OpenOffice Writer (Word processor) 
• OpenOffice Calc (Spreadsheet) 
• OpenOffice Impress (Presentation) 
• OpenOffice Base (Database Management System) 
• OpenOffice Draw (Graphics) 
• OpenOffice Math (Equation Editor) 
 
In this chapter we are discussing version 4.1.5 of Apache OpenOffice. You regularly get updated versions of 
OpenOffice. The new version of Apache OpenOffice shows a sidebar on the interface of Writer, Impress, and 
Calc. It is similar to the ribbon in Microsoft Office, which is a paid version.  
 
 
1.3 OPENING AND EXITING WORD PROCESSOR 
 

Do you Know? 

“Word Processor” was the first most 

popular Word processing software. 
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Apache OpenOffice Writer is a word processor program, which is equivalent to MS Word. It is used for 
creating, editing, formatting, and printing text documents. You can include pictures, charts, tables, and can 
save the document in various formats.  
 
To start OpenOffice Writer, click Start  All Programs  OpenOffice 4.1.5  OpenOffice Writer. 
The Apache OpenOffice Writer window, along with its sidebar and other components, is shown in Figure 1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 1 Apache OpenOffice Writer window 
 
Title Bar  The title bar is placed at  top of the Writer window. It displays  currently opened document name 
followed by the program name. If you create a new document, it shows the name as Untitled 1, Untitled 2, 
etc. This is replaced by the filename you give when you save the document. To  right of the title bar, you can 
see three buttons: Minimize, (Restore Down)Maximize and Close. 
The Minimize button is used to reduce the window to a small icon on the taskbar. The Restore Down button 
is used to make the window smaller than full size. The same button is used to bring it back to full size. The 
Close button is used to close the window. 
 
Menu bar The Menu bar, which is displayed below the Title bar, has different options like, File, Edit, View, 
etc. Clicking on a menu option displays options of this menu. 
 
Standard Toolbar It is displayed below the Menu bar and contains buttons for the most commonly used 
commands, like, New, Open, Save, etc. 
 
Formatting toolbar This toolbar has buttons for the most commonly used formatting commands. 
 
Document Window The document window is used to create a document. This is the area where you can 
type text, insert pictures etc. 
 

Title bar 
Standard bar 

Formatting 

bar 

Vertical 

ruler 

Status bar 

Zoom control 

Minimize 
Maximize/Re

store Down 

Close 

Side bar 
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Scroll bars  The horizontal scroll bar is present at the bottom of the document window and is used to move 
the document left or right. The vertical scroll bar is present to the right of the document window and is used 
to move the document up and down. 
 
Rulers The horizontal ruler is present at the top of the document window and is used to set left and right 
margins. The vertical ruler is present to  right of the document window and is used to set top and bottom 
margins. 
 
Status bar The Status bar is present at  bottom of the Writer window. It displays information about the 
current document, such as number of pages, current page number etc. 
 
Zoom control The zoom level of the document can be set by clicking, holding, and dragging the slider. 
 
Let’s Try  
 
Start OpenOffice Writer. Identify various components of the OpenOffice Writer window: - Title bar, Standard 
bar, Formatting bar, Horizontal and vertical scroll bar, Horizontal and vertical ruler, Minimize, maximize and 
Close buttons, Status bar 
 
 
1.3.1 Opening a Document 
To open an already saved document in OpenOffice Writer: 
 

1. Click the Open option from the File menu. 
Or 
Click the Open (Fig 2) button on the Standard bar. 
 
 
 
 
 
 
Fig 2 Open button on the Standard bar 
 

Or 
 

Press Ctrl + O. 
2. The Open dialog box appears. 
3. Select the Drive and the folder. 
4. Select the file and click Open button. 

 
 
1.3.2 Closing a Document 
To close an open document, click the Close option from the File menu. 
 
1.3.3 Exit Writer 
To exit Writer, click the Exit option from the File menu. 
 

Open button 
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1.4 CREATING A NEW DOCUMENT 
To create a new text document in OpenOffice Writer: 

1.  Select File  New  Text Document. (Fig 3) 
 

 
 
Fig 3   New option of File menu 
 
 
Or 
 
Click New button on the Standard toolbar (Fig 4) and select the desired option  to create a new text 
document. 
 
 
 
 
 
 
 
Fig 4 New button on the Standard toolbar 
 
Or 
 
You can also press Ctrl + N on the keyboard to create a new document. 
 
 
1.5 Saving a Document 
To save a document,  

1. Click the File menu. 
2. Select Save As option . (Fig 5) 

New Button 
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Fig 5 “Save as”  option of File menu 
 
Or 
 
Click the Save button on the Standard bar as shown in Figure 6. 
 
 
 
 
 
 
 
Fig 6  Save button on the Standard toolbar 
 

3. The Save As dialog box appears. (Fig  7) 
4. Select the location where you want to save the document. 
5. Type the file name, and click on the Save button. Documents created and saved in Writer have the 

extension .odt by default. 
 
 

Save button 
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Fig  7 Save As dialog box 
 
 
 
 
 
 
 
 
 
Let’s Try it  
 
 
Teacher can discuss with the students about  earlier Typewriter which  was used for typing. But there were 
some limitations of using a typewriter. Discuss the limitations and ask the students to  create a document 
and type these limitations. Also, the teacher can discuss about electronic typewriters, which used to print 
one line of typing at a time. 
 

1. Start OpenOffice Writer. 
2. Create a new document. 
3. Type a paragraph about limitations of using typewriter. A sample is given below: 

 
 
 
 
 
 
 
 

Limitations of Using Typewriter 

If there was some error while typing using typewriter, 

correction could not be done and entire sheet had to be 

typed again. Also, if same document or letter was to be 

sent  to different people , then it had to be typed again 

and again. The formatting of the text was also not 

possible when document was typed using typewriter. 

Keyboard Shortcut 

Save   Ctrl +S 

Save As  Shift + Ctrl + S 
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4. Save the document with name ‘typing’. 
5. Close OpenOffice Writer. 

 
Let’s Try it  
 
Now, discuss the advantages of using word processor, and ask the students to perform the following tasks on 
computer.  
 

1. Start OpenOffice Writer. 
2. Open the already saved document ‘typing’. 
3. Now add another paragraph about advantages of using word processor. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Save the document. Which option will you select to save the file with the same name –Save or Save 

As? 
5. Close the document. 
6. Exit from Writer. 

 
Let’s Try It  
 

1. Create a new document in Writer. 
2. Type a paragraph mentioning use of word processor for students, teachers, in business etc. 

Hint: You can mention that students can do assignments, type project reports in word processor. 
Teachers can prepare assignments, question papers etc. In offices, word processor can be used for 
preparing reports, writing letters, etc. 

3. Save the document as ‘word processor’. 
 
Worksheet 1 
 

1. Name the two toolbars.  ____________  ________________  

Advantages of Word processor 

The document created on computer using word processor can be saved 

and edited. The document remains saved until we delete it. The text can 

be formatted to enhance its appearance like, you can change the font, 

size and color of the text. You can also highlight important words. If 

there is some error, the document need not be typed again, corrections 

can be done in the same document. You can also check the spelling and 

grammatical mistakes. The document can be printed any number of 

times. You can insert pictures and graphs in a document. You can insert 

different shapes etc. 
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2. Name the toolbar used to scroll the document up and down ________  
3. Name the bar present at  bottom of the Writer window that gives information about  number of 

pages in the document. __________  
4. Name the two rulers ____________  ______________  
5. Name the ruler that is used to set  left and right margins __________  
6. Name the bar that has buttons for  most commonly used commands ______   
7. Name the three buttons present to  right of the Title bar. ______  
8. Name the button used to reduce the window to a small icon on  taskbar. _____________  
9. Which action/button is used to make the window smaller than full size? ___________  
10.  Mention any two features of word processors. 

___________________________  
___________________________ 
 
Worksheet 2 

1. Dhruv has to type his project report. Name the software he can use for this purpose. 

__________________________  

2. Hiren has created a new document in Word processor. In which part of the word processor window, 

name of the document is displayed? 

3. Udhav wants to reduce the window size to a small icon on the taskbar, which button should he click 

– Maximize, Minimize, or Close? 

4. Which toolbar – Standard or Formatting contains the buttons for commands like, New, Save, Open, 

etc.? 

5. Piyush wants to check the number of pages in the document. Name the bar that displays this 

information. 

6. Riya has to check left and right margins. Which ruler- Horizontal or Vertical should she check? 

7. Mudit noticed “Page 1/2  “ displayed on the left of the Status bar. What do numbers 1 and 2 

represent? 

8. Name  three buttons present to the right of the Title bar. 

9. Gurpreet’s teacher told her that there are two scroll bars in Word Processor window. Name the 

scrollbar present at  bottom of the document window. 

10. Name any one online word processor. 

 
 
Worksheet 3 
 
 

1. Write Keyboard shortcuts for the following commands: 
i. New 

ii. Save 
2. Name the menu that has option to create a new document. 
3. What is the difference between “Save” and “Save As” options of File menu? 
4. Dhriti wants to open an already saved document in word processor. Since the mouse is not working 

properly, her teacher has asked her to use the keyboard shortcut. What is the keyboard shortcut for 
Open command? 

5. Sukrit has created a new document in word processor. Which option should he use – Save or Save 
As? 



9 ICT- XI 

 

6. Udit opened an already saved document ‘My Story’. He made few changes in the document. To save 
the changes, which option should he use – Save or Save As? 
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INTRODUCTION: 

Today, all of us are concerned and worried about our future, both in terms of a good and luxurious 

lifestyle and  our focus is on healthy lifestyle.   A healthy life is only possible when the air, water, 

food is clean. This precisely means that both health (environment) and wealth are important for us 

and one cannot replace the other. 

On the contrary, if we look at human activities in the past, we will get evidences that our activities 

could not ensure that we have both wealth and health. Hence,  the economy grew, we compromised 

on our health and if we cared for our health and mended our ways for a healthy tomorrow, there 

was a dip in economic growth. 

So, what is needed is that we maintain a balance between both. If we are able to find viable 

solutions to promote economic growth and ensure that the environment is not compromised,  

meaning our health is not negotiated, we will be a Green Economy. 

What is a Green Economy? 

Collins’ English Dictionary defines Green Economy as Biological economy that is concerned with 

renewable energy, green buildings, clean transportation, water, waste and land management. 

This would mean that without compromising on the ecological aspects we create options that 

promote the economy. According to UNEP (United Nations Environment Program) a green economy 

is defined as low carbon, resource efficient and socially inclusive. In a green economy, growth in 

employment and income are driven by public and private investment into such economic activities, 

infrastructure and assets that allow reduced carbon emissions and pollution, enhanced energy and 

resource efficiency, and prevention of the loss of biodiversity and ecosystem services. These green 

investments need to be enabled and supported through targeted public expenditure, policy reforms 

and changes in taxation and regulation. The Green Economy provides a macro-economic approach 

to sustainable economic growth with a central focus on investments, employment and skills. 

Further, in order to be a Green Economy, we need to be ‘Green users’ or ‘Consumers’. The whole 

purpose of shifting to manufacturing and production of environment friendly products will be futile 

if the consumers do not use these products. Recently, there has been a rising demand of using ‘Eco-

Friendly’ products, ‘Bio-Products’. If we as consumers of products will demand for ‘Eco-Friendly’ and 

‘Bio-Products’, the manufacturers will be forced to supply it to the market. This clearly works on the 

principle of ‘Demand and Supply’. Hence, it will promote ‘Green Economy’. 

COMPONENTS OF GREEN ECONOMY: 

There are five basic components of a Green Economy: 

i. Renewable Energy: Renewable Energy is the energy produced by the renewable sources. 

Today, with the growing need of technology, continued supply of electricity is a necessity. To 

meet the demand, we need to promote alternate sources of energy such as solar, wind, 
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wave energy. Switching to these renewable sources of energy will help reduce the 

catastrophic impact on environment and promote the economy to flourish. 

ii. Green Buildings: Buildings that do not impact the environment adversely during the 

construction and use renewable energy, reduce wastage of natural resources such as water 

and manage their waste effectively are called Green Buildings. Today, there is a rising need 

for self-sustained green buildings. Promoting green buildings will not only help preserve the 

resources for future generation but will also help in economic growth. 

iii. Green Transport: With the advancement in technology, there are now alternates to 

conventional transportation that used to run on petrol or diesel. It is not long ago, that the 

government in India promoted Compressed Natural Gas (CNG) to run the vehicles. 

Introduction of Electric Vehicles and public transport that run on electricity is playing a major 

role in furthering the sustainable development. These are not only contributing in preserving 

the air but also ensure that economy is expanding. 

iv. Water Management: The recent crisis in the city of Cape Town, popularly known as ‘Day-

Zero’ is an alarming situation in many metropolitans across the globe. The drought like 

situation has not only given blow to the world but has affected the economy also. The only 

possible solution to this problem is to reduce the wastage of water and replenish the ground 

water levels by adopting Rain Water Harvesting Systems (RWHS) in our communities. This 

will ensure to have a society that is self-sustainable for its basic water requirement. 

v. Waste Management: Any kind of waste will contribute in causing air, water and land 

pollution. This also adds to wastage of resources. Our craving to buy new and discard old, 

even if it is usable is resulting in environmental degradation. Hence, it is pertinent for us to 

follow 4 Rs’ – REFUSE, REDUCE, REUSE, REECYCLE and 1 U Upcycle. We must incorporate to 

segregate our waste at source. The basic segregation of wet waste (biodegradable waste) 

and dry waste (all other kind of waste) in our houses and workplaces will help recycle the 

used products. The wet waste can be composted and used in the gardens while the dry 

waste may be either recycled or upcycled. 

POLICY INITIAVTIVES FOR GREENING ECONOMY IN INDIA: 

 Government of India has promoted and initiated number of policies to promote sustainable 

development. We are going to read few of these policies: 

1. WILDLIFE PROTECTION ACT, 1972 - The Wildlife Protection Act, 1972 is an Act of 

the Parliament of India enacted for protection of plants and animal species. Before 1972, 

India had only five designated national parks. Among other reforms, the Act established 

schedules of protected plant and animal species; hunting or harvesting these species was 

largely outlawed. The Act provides for the protection of wild animals, birds and plants. 

2. THE WATER PREVENTION AND CONTROL OF POLLUTION ACT, 1974, amended 1988 - Water 

(Prevention & Control of Pollution) Act, 1974 is a comprehensive legislation that regulates 

agencies responsible for checking on water pollution and ambit of pollution control boards 
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both at the centre and states’ level. The Water (Prevention & Control of Pollution) Act, 1974 

was adopted by the Indian parliament with the aim of prevention and control of Water 

Pollution in India. The act was amended in 1988 to clarify the ambiguities and to vest more 

powers in Pollution Control Board. 

3. ESTABLISHMENT OF CENTRAL POLLUTION CONTROL BOARD - The Central Pollution Control 

Board (CPCB) of India is a statutory organisation under the Ministry of Environment, Forest 

and Climate Change (Mo.E.F.C). It was established in 1974 under the Water (Prevention and 

Control of pollution) Act, 1974. The CPCB is also entrusted with the powers and functions 

under the Air (Prevention and Control of Pollution) Act, 1981. It serves as a field formation 

and also provides technical services to the Ministry of Environment and Forests under the 

provisions of the Environment (Protection) Act, 1986. It Co-ordinates the activities of the 

State Pollution Control Boards by providing technical assistance and guidance and also 

resolves disputes among them. It is  an apex organisation in the country in the field of 

pollution control, as a technical wing of MoEFC. The board is led by its Chairperson, who is 

generally a r civil servant from the Indian Administrative Service appointed by 

the Appointments Committee of the Cabinet of Government of India. 

4. THE TERRITORIAL WATERS, CONTINENTAL SHELF, EXCLUSIVE ECONOMIC ZONE AND OTHER 

MARITIME ZONES ACT, 1976 -   It is an Act to provide for the regulation of fishing by foreign 

vessels in certain maritime zones of India and for matters connected therewith. 

5. FOREST CONSERVATION ACT, 1980 - The Forest (Conservation) Act, 1980 an Act of 

the Parliament of India to provide for the conservation of forests and for matters connected 

therewith or ancillary or incidental thereto. It was further amended in 1988. This law 

extends to the whole of India. It was enacted by Parliament of India to control 

further deforestation of Forest Areas in India. The act came into force on 25 October 1980. 

6. ENVIRONMENT PROTECTION ACT, 1986 - Environment Protection Act, 1986 is an Act of 

the Parliament of India. In the wake of the Bhopal Tragedy, the Government of India enacted 

the Environment Protection Act of 1986 under Article 253 of the Constitution. Passed in 

March 1986, it came into force on 19 November 1986. The purpose of the Act is to 

implement the decisions of the United Nations Conference on the Human Environment. 

They relate to the protection and improvement of the human environment and the 

prevention of hazards to human beings, other living creatures, plants and property. The Act 

is an “umbrella” legislation designed to provide a framework for central government 

coordination of the activities of various central and state authorities established under 

previous laws, such as the Water Act and the Air Act. 

7. NATIONAL FOREST POLICY, 1988 - The principal aim of National Forest Policy, 1988 is to 

ensure environmental stability and maintenance of ecological balance including atmospheric 

equilibrium which is vital for sustenance of all life forms, human, animal and plant. 

8. THE NATIONAL ENVIRONMENT TRIBUNAL ACT, 1995 – In 1995, the Central Government 

established the National Environment Tribunal (through  the National Environmental 
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Tribunal Act 1995) to provide for strict liability for damage arising out of accidents caused 

from the handling of hazardous substances. 

9. NATIONAL GREEN TRIBUNAL ACT, 2010 – The National Green Tribunal has been established 

on 18.10.2010 under the National Green Tribunal Act 2010 for effective and expeditious 

disposal of cases relating to environmental protection and conservation of forests and other 

natural resources including enforcement of any legal right relating to environment and 

giving relief and compensation for damages to person and property and for matters 

connected therewith or incidental thereto. It is a specialized body equipped with the 

necessary expertise to handle environmental disputes involving multi-disciplinary issues. The 

tribunal’s dedicated jurisdiction in environmental matters shall provide speedy 

environmental justice and help reduce the burden of litigation in the higher courts. 

10. BIOLOGICAL DIVERSITY ACT, 2002 – The convention on Biological Diversity (CBD) was 

inspired by the world community’s growing commitment to sustainable development. It 

represented a step forward in the conservation of biological diversity, the sustainable use of 

its components, and the fair and equitable sharing of benefits arising from the use of genetic 

resources. In pursuance to the convention on Biological Diversity (CBD), to which it was a 

signatory, India enacted the Biological Diversity Act in 2002 following a widespread 

consultative process over a period of eight years. The Biological Diversity Rules were notified 

thereafter in 2004. 

11. NATIONAL WATER POLICY - National Water Policy was  formulated by the Ministry of Water 

Resources of the Government of India to govern the planning and development of water 

resources and their optimum utilization. The first National Water Policy was adopted in 

September, 1987. It was reviewed and updated in 2002 and later in 2012. 

STAKEHOLDERS IN GREEN ECONOMYAND THEIR ROLE: 

A stakeholder in an economy is someone who has the ability to affect or be affected by the 

growth or fall of the economy. Hence, in a Green Economy, the Government (the policy maker), 

the private agencies (business that will either contribute to build the green economy or get 

affected because of change in policies), the people (who will be affected) are the stakeholders at 

large. 

1. Government: In any economy government has the key role. Similarly, in green economy 

also, it is the force with which the government of a nation pushes the need of greening the 

economy. All units of the government are involved in one or the other way in planning, 

budgeting and execution of the policies. In context of our country where we have 

government at multiple levels, involvement at every level is important and hence, whether it 

is central or state government or municipal corporations, all are stakeholders. Some major 

branches of the government – Ministry of Finance, Ministry of Petroleum, Ministry of 

Environment and Forest, HRD Ministry, Education Department, Ministry of Health and 

wellness, Ministry of Tourism, Ministry of Transportation etc. have major contribution in 

defining the green economy of the country or state. 
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It is because of the efforts of the government that today in our country a lot of initiatives 

such as ban on polythene, Clean India, Green India Campaigns, Cleaning of rivers, 

sensitization programmes across the schools in the country are paving way for the young 

generation to contribute in creating Clean and Green Environment. 

2. The Private Agencies: Private agencies have a crucial role in giving shape to the policies. If 

the policies are designed but the private agencies fail to execute them as planned, it will 

have a deep impact on the economy. It is the private agencies that plays dual role. These are 

the ones  who give shape to the policies but they are also the ones who are affected with 

every small change. No economy can blossom without the engagement of the private 

agencies. Private agencies in every field – education, health care, food production, 

transportation, construction, tourism, agriculture etc. enable the policies to reach to the 

public. The public derives benefits only when private agencies perform their role properly. 

Private agencies generate revenue; create employment options through transparent and 

accountable taxation. The private sector has the potential for innovation and develops 

solution for urban cities. The private and public partnership is the driving force to create 

promising Green Economy. 

The areas where the government is not able to lay emphasis or provide a solution, private 

agencies come into play. Sectors of a sustainable society such as waste management 

including e-waste management, promoting organic farming, creating opportunities of 

employment in waste management and laying the way for young entrepreneurs etc. are a 

few to name that are taken care by various private agencies including NGO’s 

3. The People: The last but the most important stakeholders in a green economy are  the 

people of the nation. Any economy exists because of its people. Government brings many 

policies but the success of the policies  depend on how the people have adopted the change. 

If the policy affects the people negatively, it is bound to collapse. Hence, while laying down 

the policy, it is pertinent for the government to keep in mind the demographics and the 

interest of its people. The factor like education of the people of a nation also plays a pivotal 

role in peoples’ collaboration. If the masses are not educated and aware about the latest 

trends and needs, they will either reject the policies or would not be able to contribute to 

the extent to bring a desirable change. 
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